Holdem Bot User Manual

Warning: BonusBots.com is the only legal site for buying the Shanky Technologies Bots!

Last revised March 14, 2023 © www.BonusBots.com
# Table of Contents

List of Currently Supported Poker Rooms ................................................................. 4

1. Quick Start .................................................................................................................. 5
   1.1 Installation and Program Access ........................................................................... 5
   1.2 Poker Room Settings ......................................................................................... 10
   1.3 Additional Stealth ............................................................................................... 36
   1.4 Sitting in a Game and Starting the Bot ............................................................... 37
   1.5 Multi-Tabling ..................................................................................................... 38

2. Profiles ...................................................................................................................... 39
   2.1 Using Different Profiles ..................................................................................... 39
   2.2 Creating (or Tweaking) Your Own Profile ....................................................... 40
   2.3 Saving Profiles .................................................................................................. 44

3. Detailed Instructions for Holdem Bot ................................................................. 51
   3.1 Run Bot as Administrator (Vista only) ............................................................ 51
   3.2 Seat Position ..................................................................................................... 51
   3.3 Free Trial Notes ............................................................................................... 51
   3.4 Where to Put the Program .............................................................................. 52
   3.5 Session Log ....................................................................................................... 52
   3.6 Which Games to Play ...................................................................................... 52
   3.7 Hiding the Bot .................................................................................................. 53
   3.8 Game Type Menu ............................................................................................. 53
   3.9 Options Menu ................................................................................................... 53
   3.10 Saving Profiles ................................................................................................. 60
   3.11 Switching Profiles Mid-Session ................................................................. 61
   3.12 Custom Coding Profiles With PPL ............................................................ 61
   3.13 Setting Your Own Default Profile .............................................................. 61
   3.14 Multi-Tabling ................................................................................................. 62
   3.15 Waiting for a Table ......................................................................................... 63

4. Running the Program ............................................................................................... 64

5. Miscellaneous .......................................................................................................... 64

Poker Bot Strategy ...................................................................................................... 65
   Introduction ............................................................................................................. 66
   Types of Poker Bots ............................................................................................... 67
   Staying in Stealth Mode ....................................................................................... 68
   Sit-out Options ....................................................................................................... 68
   Max Session Time ................................................................................................ 69
   Playing Sessions .................................................................................................... 69
   Bathroom Breaks ................................................................................................... 69
   Avoiding Being Profiled ....................................................................................... 69
   Poker Room Upgrades ......................................................................................... 70
   The Rake: Your Worst Enemy .............................................................................. 70
List of Currently Supported Poker Rooms

**Ignition Casino Poker** (USA-friendly Bodog platform)
**Bovada Poker** (USA-friendly Bodog platform)
**Bodog Poker** (No USA Players)
**Bodog88** (where available)

**America’s Cardroom** (Winning Poker Network, USA)
**Black Chip Poker** (Winning Poker Network, USA-friendly)
**True Poker** (Winning Poker Network, USA-friendly)
**PokerKing** (Winning Poker Network, USA-friendly)

**PPPoker** (Private clubs, invites from agents or club owners required)

**Poker Saint** (Enterra network, Evenbet poker app)

*All iPoker Sites in All Countries, Including* (but not limited to):
**Bet365 Poker**
**Titan Poker & TitanBet**
**Betfair Poker**
**William Hill Poker**
**Winner Poker**
**NetBet Poker**
**Paddy Power**
**Holland Casino Poker**
**Dafa Poker**
**EuroBet**
**Boyle Poker**
**Mansion Poker**
**BetnGo**
**BetFred**
**Expekt Poker**
**Bet365.it** (iPoker room, bot reads Italian here)
**Betfair.it** (iPoker room, bot reads Italian here)
**Titanbet.it** (iPoker room, bot reads Italian here)
**Eurobet.it** (iPoker room, bot reads Italian here)
**Sisal.it** (iPoker room, bot reads Italian here)
**Betclic.fr** (iPoker room, bot works in English or French here)
1. Quick Start

1.1 Installation and Program Access

Unless you changed the path on the download screen, the bot was installed at **C:Poker\data**. A dozen or so additional files came with the download which should all be in that folder together, including several different playing profiles we included with the download. So, the bot folder can be accessed by first going to **Computer** (or **This PC**) and then **Local Disk C:** and then opening the folder named **Poker** and finally the subfolder there named **data**.

Tip: A quicker way to get to the bot folder, if you have a desktop icon for the bot, is to right-click on it and select **Open File Location**

The bot itself is named **holdembot** (or holdembot.exe) and can be opened on a Windows 7, Windows 8, or Windows 10 machine by simply double-clicking it. We no longer recommend using XP or Vista, although in many cases the bot will still work on those systems without any issues.

Please note additional temporary files will appear in the bot folder once you open the bot, including the bot’s own recorded session log – which is a text file titled **holdem** (or holdem.log) and records everything the bot saw and did in the last session, and also gives a reason for each action taken.

**Use of Desktop Icons:** By default the installation program creates a shortcut called “holdembot” on your desktop. But you can also create a desktop shortcut to the entire bot-folder as well, if you like. To do this, right-click on the bot folder (the ‘data’ subfolder inside the ‘poker’ folder) and choose **Send To** and then choose **Desktop (create shortcut)**. After the shortcut to the folder appears on your desktop, you can rename it by right-clicking on it and choosing **Rename** from the popup menu. You might want to rename it something innocent-sounding like **faxes**.

**Windows 7.** Please use the default **Aero** theme if running Windows 7.

**Windows 8.** While we prefer Windows 10 or Windows 7 for our software, the bot will work on most Windows 8 computers as long as you have updated to Windows 8.1. You may also like to read this thread in our support forum where other Windows 8 users have reported on what they did to optimize it for the bot:

https://bonusbots.com/support/index.php/topic,7405.0.html

(You will need to log into our support forum first in order to access that board. There is **a lot more** to our support forum than what is visible to guests –)
including profile and add-on software marketplace boards – so make sure you get registered there and log in to check it all out!

**Windows 10.** Windows 10 is now fully supported for our bot, with all our supported sites. No special settings are needed other than language set to English/US or Italian.

**Errors reported by bot on start-up:** When you start the bot it will check your PC display settings and give a numbered error message if they do not match those required by the bot. The Appendix at the end of this document tells you how to correct each of these errors. If you get any of them, please refer to the Appendix to correct them before proceeding further. If you are unable to rid yourself of the error message, please contact us by email.

**Verify Bot Window Data:** After setting the poker room options described in section 1.3 below, go ahead and put the bot in a low stakes cash game, at one table only, and keep the bot window open on your screen. Watch closely and make sure accurate information is being reported in the bot window. Especially pay attention to the big blind size and your stack size figures – if those are not being reported accurately, the bot will appear to play like a maniac because it thinks your stack is extremely low. If the information scrolls too fast for you to read, you can close the bot and verify the data in the bot’s session log (see section 3.5 for a detailed explanation on the session log).

**English Language Regional Settings in Windows.** Our bot needs your Windows language to be in **English/US** or **Italian** (the only possible exception is French; you can try with French language first and see if it works). From the Control Panel in Windows, find the Language and Regional Options. Set this to **English / United States.** (Please note that **English / United Kingdom** can cause problems due to their using commas in place of decimals, so do not use that.)

If your native Windows language is not **English** and the bot does not report the correct big blind size or stack size in the open bot window (or reports stack = unknown) even after changing your Windows language to English/US, you may also need to adjust your language for non-unicode programs. Here is the exact path for doing that in Windows 7 (and Windows 10 will be similar):

Control Panel >
   Clock Language and Region >
   Change Keyboards or other input methods > set keyboard language to English here
      Administrative tab >
         Language for non-unicode programs > here set this to English/US

Don’t forget to make sure your keyboard language is set to English /US on the third step on the above path. Windows 10 will have a similar path from the control panel.
Poker room setup: The list of currently supported poker rooms is at the beginning of this manual. Each supported poker room requires some setup steps before the bot will work there (see below). The bot may also play at additional sites on the same network as any of our officially listed sites – if not, it is probably an easy add for us so contact us to request it.

Do not attempt to run the bot before fixing error messages and doing the necessary setup at the poker room you want to play at. This is critical. If you don’t fix error messages in the bot window and/or do the required poker room setup, the bot may not be able to read the cards, big blind, stack sizes, or the situation properly - and as a result may appear to act erratically.

**Desktop Display.** The bot is sensitive to screen display and will not usually work on unusual screens such as a television or dual monitor. Touch-screen hybrid “convertible” laptops are also problematic and usually won’t work.

Please make sure your screen Display DPI is set to 100%, the smaller setting:

- **Right-click on Desktop > Choose Personalize (or Display on Windows 10)**
  - Select Display (in lower left) in Windows 7
  - Make sure Display is set to 100%, the smaller setting

**Anti-Virus and Anti-Spyware Warnings:** If you get a warning message from your anti-virus software about our program, it is a false positive. Some security programs don’t like the looks of our software. Rest assured our software is 100% safe. We have been in business since 2006 and have over 10,000 members in our support forum. Tell your Anti-virus to leave the bot folder alone and let our script run (you may even need to disable the file shield function of your AV program in order to run the bot).

The alternative is to disable your anti-virus program, download the bot again, and keep it disabled while you play.

**Language for Poker Room Client.** Our poker bots can only read United States English or Italian (French iPoker rooms are a possible exception) so you must be using one of these language options on the poker room software.

**If the only action the bot ever takes is folding** even when the instructions in the bot window say to raise or call, you may have a CPU configuration issue on your PC that can be fixed by setting it to use only one core. The path for making this adjustment is as follows:

- **START / All Programs / Accessories / Run >**
  - In the Run window type in MCONFIG and hit enter >
  - In the **BOOT tab** click on Advanced Options >
  - Put a tick in **Number of Processors** and set it to 1
**Taking a Screenshot:** There is a built-in *Take Screenshot* button on the bot. When pressed, this function saves the current screen image, in addition to a completed output copy of the current log, to the bot folder. The image is a special file type which won't open on most PCs, but is reviewable by our developer. If you wish to view the image yourself, you can download a free app called *Irfanview* here:

http://www.irfanview.com/main_download_engl.htm

If you are having any kind of issues with the bot, click the *Take Screenshot* button (when the problem is on screen) and email the image + log to us.

**Options Settings Menu**

The bot includes many behavioral options the user can set. These are found on the main bot menu by clicking on **Options**. Notice the choices are organized into sub-menus.

**Not all of these settings will override profile instructions, however,** so be sure to read **Section 2** of this manual to gain an understanding of how profile instructions are prioritized. Most of the time you probably want to use a text profile, so will not mess with the option settings that affect play (as those options would likely not ever be activated, being overwritten by the profile).

**Options Settings that Always Work**

The following option settings override profile instructions, so will always work. Some of these can be important to your objectives.

**Sit-out Options**

This group of options allows you to tell the bot to quit playing after a certain amount of time, certain number of hands, when your stack size grows to a certain level, or when the number of opponents at your table shrinks to a certain number. In the case of the *opponent count*, the bot will **sit back in** when the opponent count grows back to the number you select here (unlike the PPL sit-out command, which is permanent). All other sit-out commands on this menu are permanent sit-outs, except for the bathroom break.

**Bathroom Break Setting (Under Sit-out Options)**

You may want the bot to take breaks in cash games, to mimic being human. You can set the interval and the time of the break. The shortest allowed break time is 2 minutes. It is not recommended to take breaks much longer, as you are likely to get removed from the table. A good setting for cash games is 2 minutes every
80-120 minutes. If you do not want the bot to take a bathroom break, such as when you are playing in a tournament, simply set the interval to 900 minutes.

**Max Players Allowed at Table**

This option lets you manually tell the bot what table type you are on, in case it is having trouble auto-detecting the player count. If you are sitting at a 6-max table, for example, and notice the player count occasionally saying 7 or 8, try setting this to 6 (and vice-versa). The bot will then know the correct opponent count by combining this setting with the fold count when it is your turn to act.

**Log to File**

You can output a real-time session log, a text file that records everything you see reported in the bot window, to a location of your choosing such as your desktop. When this option is enabled it is in lieu of the normal session log, so the usual (delayed) session log created in the bot folder will not be produced. This feature may be handy for copying out hands you observe before they get buried in the log.

**Other Settings**

Occasionally we put a “poker country switch” on this menu for certain sites to tell the bot which poker client you are using if there are differences in the clients between countries. You should check with us (in our forum or by email) before setting one of these switches to see if it is currently recommended.

**Rakeback & Bonuses**

For Rakeback and special deposit bonus deals sign up for your poker room accounts through this link:

https://tinyurl.com/b3jrz4
1.2 Poker Room Settings

Bodog / Ignition Casino Poker / Bovada / Bodog88

The following poker room settings adjustments are all critical and must be set accordingly (from the lobby) in order for the bot to function properly.

1. On the Table Settings tab make sure the red background, default deck, and the black card back are selected.

Nothing else matters on this tab, but it is good to turn off opponent chat for botting.
2. On the **Game Play Settings** tab under **Game Play Setting** you should match the following settings.

The most important thing here is to have **Disable Pop to Front** unchecked!
3. Still on the same Game Play Settings tab, but now under Seating, make sure Do Not Use Preferred Seating is unchecked. Please note this is a different instruction now than we gave for past versions of their poker client.

In addition, set the preferred seat for each table type as bottom-center, unless there is no bottom center seat in which case set it as bottom-right.

4. On the Default Buy-in tab Auto-Post Blind should be enabled (although this is not critical for bot play).
5. Finally, the first time you open a table **close the sidebar window** on the right side, before starting the bot. Our bot cannot play if this is open. Please note this entire window must now be closed, including the chat, not just the mini-games on top.

Do this by clicking the little arrow on the right side. You should only need to close this once, the first time you open a table.

**Start the bot after** you take a seat at a poker table! Simply click the start button on the bot menu. To stop it, click the stop button.
Ignition / Bovada / Bodog Troubleshooting

* No sidebar on the poker table window -- click the arrow in the middle of the right side to collapse it completely. Please note this has recently changed and now the entire window must collapse, not just the mini-games on the top half.

* You must always be in the bottom center seat, and must use preferred seat view to stay there. Double-check your Ignition/Bovada settings to make sure they match with the ones shown in the screenshots in the Easy Start Guide PDF.

* Make sure no other software is running/open when the bot plays (including web browsers, Teamviewer, etc), and minimize the lobby.

* If you are using a dual monitor please disable it completely and use only the first monitor. Similarly, if using a laptop do not attempt to use an external monitor -- use the laptop screen. Also, TV screens and "convertible" laptop-tablet hybrids usually do not work. We recommend a single standard non-touch screen monitor (although laptops with touch screens often work as long as they are not a convertible tablet, especially if there is an option to disable the touch screen).

* Your screen display must be on "100%" (not 125%). Right-click on your desktop, go to Display (or Personalize > Display on Windows 7) and make sure this is set to "100%" or "100%, Smaller."

* Your windows language must be set to English/US and you must be using English language in the poker room client.

* If running Windows 7 please use the default "Aero" Windows theme.

* Finally, you can try playing with your resolution setting and see if you find one that works better.
Winning Poker Network
(America's Cardroom, Black Chip Poker, True Poker, PokerKing)

Important: Additional stealth is now required for these sites (given at end).

1. On the Playing Experience > Gameplay tab match the following settings. It is especially important to have and Show player avatar and Use tournament final table graphics unchecked!
2. On the **Playing Tools** > **Gameplay tab** match the following settings. It is especially important to have and **Show chips as # of big blinds** and **Auto switch between tables** unchecked!

![Playing Tools: Gameplay settings](image1)

3. On the **Playing Tools** > **Bet Sizing tab** match the following settings. Note that only one of these should be checked.

![Playing Tools: Bet Sizing settings](image2)
4. On the Table Design tab, the following settings are all mandatory and must be set as shown (green felt, 2-color deck, default card backs):

5. On the Table Design > Lobby tab, match these settings (English language and do not enable the dark lobby).
Important additional stealth measures now required for these (WPN) sites. They started looking for our bot, and will require a ridiculous list of identity verification steps if they detect it, and likely ban you even after you comply with the list. Do not keep much money in your account if you bot here, and take the following extra stealth measures:

1. Rename the “Poker” folder on your C:Drive to something else, and then move the folder somewhere else such as inside one of your Windows folders in your Program Files. Also rename the “data” folder inside it.

2. Delete the desktop shortcut (do not neglect this step!)

3. You now need to rename the bot file, create a new desktop shortcut to the renamed bot file (optional), and set the new shortcut to Run as Administrator the same way our Ppoker setup shows.

4. When you get your license, keep it inside the buried bot folder, not on your desktop or on your C:Drive.

Start the bot after you take a seat at a poker table! Simply click the start button on the bot menu. To stop it, click the stop button.

Rakeback: Some of the poker rooms on this network offer a 27% rakeback deal which you can access here: https://tinyurl.com/b3jrz4
WPN Network Troubleshooting (Americas Cardroom, etc.)

Please check the following:

1. Windows language and poker room language must both be in English (and Windows language should be English/US specifically)

2. Please make sure your poker room settings include:

   A) On the Playing Experience > Gameplay tab make sure "Show avatars" is unchecked

   B) On the Playing Tools > Gameplay tab make sure "Auto Switch between Tables is unchecked

   C) On the Table Design tab make sure you are using the 2-color deck and the green default felt (the first option)

   C) On the Preferred Seating tab make sure the bottom-middle seat is selected for tables which have one; for those that don’t set it for bottom-right. This setting is now mandatory.

3. Your Display DPI on your PC must be set to 100% (not 125% as some Windows 10 laptops come set from the factory). Right-click on an empty space on your desktop and find your Display settings (on Windows 7 it goes through 'Personalize')

4. For 8-player tables (including tournaments using 8-Max tables) please manually adjust the Option setting on the bot as follows: Options > Max Players Allowed at Table > 8

5. Not using a dual monitor, right? Or an external monitor hooked to a laptop? Or a TV screen as a monitor? (A dual monitor, if even hooked to the tower, may need to be disconnected completely.) Please note "convertible" laptop-tablet hybrids with a detachable touch screen do not usually work, either. Update: Unfortunately, "all in one" PCs seem to be problematic as well. We recommend a spare laptop or a traditional PC tower hooked to a standard-size monitor.

6. Make sure no other software is running/open when the bot plays (including web browsers, Teamviewer, etc), and minimize the lobby.

7. Sometimes display-related problems at this site can be fixed by changing your Windows screen resolution to a 4:3 ratio and the "Scale" setting to "Centered"
PPpoker

Please note that emulators (such as Bluestacks etc.) are not supported. You must use a Windows PC and the Windows download of PPpoker. If you live in a country where the Windows download page (PPpoker.net) is blocked, you can use a free VPN to download it. We recommend Windscribe and any Europe IP address such as France.

Important: You must rename the poker bot file (in the file folder location, not the desktop shortcut) or this platform will block you when you start the bot with a “prohibited software detected” message.

You also must delete the original desktop shortcut (to holdembot.exe) or PPpoker will see it and block your access. But that is all they do, and we have supported them for 8+ months since they started doing it and bans are rare. Your funds should be safe with your agent and club owners never ban anyone.

The fix is easy:

1. Right-click the original desktop icon and select Open file location

2. Rename the file holdembot.exe to something like Skype.exe

3. Create a new desktop shortcut to the renamed bot: Right-click and select the menu item Send to > Desktop (create shortcut)

4. Delete the original desktop shortcut to holdembot.exe

5. Set the new desktop shortcut (to Skype.exe, or whatever) to Run as Administrator: Right-click, go to Properties, click on the Advanced button, check box to Run as Administrator, and save. Or you can just remember to always open it to run as administrator from the mouse right-click menu.

To see a video of us doing this go to: https://youtu.be/o1uXMuS1F9I
Required Ppoker Settings:

1. Close the initial log-in window (by clicking the X in the upper right corner) to get to the first option settings screen. Here, select the **338 x 600 table size** and also the **English language**.
2. Once you are logged in, go to any poker table. From the poker table, click the hamburger menu in the upper left to get to **Table Settings**. Then you need to take care to match the settings shown below. Especially make sure that **Card Squeeze** is disabled, and that **Exact Betting** is enabled.
3. **On the Game Settings tab** make sure you are using the **2-Color deck** and the **green table felt** (both of these are the default setting). The bot cannot see the 4-color deck or play on a different color felt!

**Beeping:** When the bot encounters something that needs your attention (such as a captcha puzzle to solve or the "rebuy chips" screen) it will make your PC beep at you. So if you are in the area and hear the PC beeping when the bot is playing at PPpoker, you need to scoot over to your PC and handle it to avoid being removed from the table.

That's it (as long as your PC Display setting is 100%).

**PPpoker Troubleshooting List (updated)**

If you are having trouble make sure:

- Your PC "Display Setting" is set to 100%

- PPpoker Table size is set to 338x600 (set this BEFORE you log in, click the little X)

- PPpoker language is English

- 2-Color Deck (not 4-color) which is the default, and default green table felt (under Game Settings, you must set that from an open table)

- Card Squeeze and Card sort are disabled (under Table Settings)

- Customized Action Buttons are DISABLED (under Table Settings)

- Exact betting is ENABLED (under Table Settings)

- Disable **Game stats** if the club has them

- No dual monitor, do not use a TV screen as a monitor or an external monitor on a laptop, do not use a convertible laptop-tablet, do not use an 'all-in-one' PC.

- Original desktop shortcut was deleted, not just renamed, bot .exe program file was renamed, and any then newly-created desktop shortcut is running "as administrator"

If you still need help, [contact us by email](mailto:) and we will come on by **Anydesk** to help with your PPpoker setup.
**Start the bot after** you take a seat at a poker table! Simply click the start button on the bot menu. To stop it, click the stop button.

**Watch the bot** after you first start it to make sure it is reporting the correct Big Blind size and your correct stack size. If not, or if you experience any other problems, please contact us by email or forum.

To play multiple tables see the multi-tabling instructions [here](#).
Enterra / Evenbet Clubs (Poker Saint)

Please note that emulators (such as Bluestacks, LDplayer, etc.) are not supported.

You must use a Windows PC and the Windows download client for these clubs powered by Evenbet software. The bot will not work on the web-based version of the poker club, or on the mobile version through an emulator.

1. **English language** is required in the poker client.

2. Match the following **Table settings** on the Options menu (these should all be default except the **Run it twice** option):

![Options settings](image.png)

- **Table settings**:
  - Auto muck cards
  - Auto post blinds
  - Bet using Enter key
  - Focus table on your turn
  - Display bet amounts
  - Show dealt cards in Chinese
  - Run it twice
  - Confirm Fold while Check is available
  - Mouse cursor on active table
  - Activate table on mouse move
  - Display table money amounts in BB

---

**Enterra / Evenbet Clubs (Poker Saint)**

**Please note** that emulators (such as Bluestacks, LDplayer, etc.) are not supported.

You must use a Windows PC and the **Windows download** client for these clubs powered by Evenbet software. The bot will not work on the web-based version of the poker club, or on the mobile version through an emulator.

1. **English language** is required in the poker client.

2. Match the following **Table settings** on the Options menu (these should all be default except the **Run it twice** option):

![Options settings](image.png)
2. Match the following *Table themes* on the Options menu. Please note that you must use the *2-color deck*. 
3. The **seat position** is critical. You must be in the **bottom-right seat view** at the table. It can only be set from a table, in the following manner:

**A)** Sit down at a table, either 6-max or 8-max, in any seat.

**B)** Right-click your mouse on the **bottom right seat** on that table.

**C)** Click **Favorite Seat** on the mouse popup menu. You only have to do this once but you must do it for each table type (6-max and 8-max).
That's it! (As long as your PC Display is set to 100%)

Start the bot after you take a seat at a poker table! Simply click the start button on the bot menu. To stop it, click the stop button.

Watch the bot after you first start it to make sure it is reporting the correct Big Blind size and your correct stack size. If not, or if you experience any other problems, please contact us by email or forum.

To play multiple tables see the multi-tabling instructions here.
iPoker Network Including but not limited to: Bet365 / Titan & TitanBet / Betfair / William Hill / Winner / NetBet / Paddy Power / Boyle / BetFred / Holland Casino / Expekt / BetnGo / Betclic.fr / Bet365.it / Titanbet.it / Snai.it / Bet365.es

Important Note: If there is a side games bar next to the poker table it must be closed for the bot to work at all iPoker sites!

The following poker room settings adjustments are all critical.

1. On the General tab choose Classic Mode and disable as many of the other options as you can stand. Less things showing on the table or popping up is better for the bot.
2. On the Avatar tab disable player avatars. This is critical.

3. Set your Themes tab to use the green Classic style cards & 2-Color deck:
Scroll down on the Themes tab and select the **first green felt table** on the list. For some sites this will be the **Default** table:

For other sites it will be the **Classic** table style.
4. On the **Animations** tab turn off all animations!

![Image of Animations tab with options unchecked]

5. Set your **Table** tab to disable just about everything but **Highlight table**:
While still on the Tables tab click **Configure Betting Buttons**: 

![Configure Betting Buttons](image)

**Important**: You must configure your betting buttons as follows:

![Configure betting buttons](image)

- **Buttons 2** and **Buttons 3** must be configured for **Pot and Max** as shown.
- **Button 4** must be set to **Disabled** as shown.
- Button 1 does not matter.
6. Set your Multi Tables tab to select all three Steal focus options only:

7. If the site offers a Player HUD tab, disable the Player HUD!

8. Close any sidebars in the poker table window! These vary by site. Only the poker table must be in the poker table window! If there is a sidebar, there will be a button to close it so the poker table expands to occupy the entire window.

Start the bot after you take a seat at a poker table! Simply click the start button on the bot menu. To stop it, click the stop button.

Watch the bot after you first start it and make sure it is reporting the correct Big Blind size and your correct stack size.
**iPoker Troubleshooting**

* No sidebar in the poker table window. There should only be a poker table; if there is any kind of sidebar please find the button to click to make it vanish or minimize to the side. This includes "mini games" and casino game ads. They can't be there.

* Stack size must be displayed in currency, meaning real money, not by the number of big blinds! (This is a relatively new option in the settings.)

* Green table felt (at some sites this is the "default" table style -- at others it is "classic").

* If "Auto Center my seat" is an option (on the Table tab or elsewhere) enable this

* Player avatars are disabled, right? These cannot be showing on the table.

* Animations are all turned off, right? See screenshot in our latest PDF setup instructions.

* If Player HUD is an option, make sure it is disabled!

* Display DPI on your PC is set to 100% (not 125% as some PCs come set from the factory). Right-click on an empty space on your desktop and find your Display settings.

* Windows language set to English/US (Italian rooms are the exceptions)

* English speaking version of the poker client (Italian rooms are exceptions)

* Configured the betting buttons in the poker client properly, as shown in our PDF screenshots, for Pot and Max

* For 8-player tables (including 8-max tourney tables) please manually adjust the Option setting on the bot as follows: **Options > Max Players Allowed at Table > 8**

* Not using a dual monitor, right? Or an external monitor hooked to a laptop? Or a TV screen as a monitor? (A dual monitor, if even hooked to the tower, may need to be disconnected completely.) Please note "convertible" laptop-tablets with a touch screen do not usually work, either. We recommend a single standard non-touch screen monitor (although laptops with touch screens often work as long as they are not a convertible tablet, especially if there is an option to disable the touch screen). Update: Unfortunately, "all in one" PCs seem to be problematic as well. We recommend a spare laptop or a traditional PC tower hooked to a standard-size monitor.
1.3 Additional Stealth

While the Holdem Bot comes includes a built-in Hiding feature, there are some additional steps you can take to hide it on your system even further. We want to stress, however, that we think this is usually unnecessary unless we give site-specific setup instructions to do so. Poker site crackdowns on botting are rare. Your best defense is to simply not play inhuman-looking marathon sessions.

Moving and renaming the bot folders.

A) Create a new folder on your PC somewhere, on your C: drive should be fine, and name it something creative like “photoedits.”

B) Rename the two folders that installed on your C: drive when you downloaded the bot. (Remember, on your C: drive there is a folder titled Poker and within that a folder titled Data, rename both of those to something that has nothing to do with poker).

C) Move the outer of the two bot folders that you renamed in Step B above into the new folder that you created in step A above.

Example: New folder was named photoedits, Poker folder was renamed install, Data folder was renamed records. So the path to your bot folder is now C:\photoedits\install\records. You will need to navigate there to access the bot and also when downloading bot upgrades.

D) Move your license file into the bot folder with the bot (if you had it on your C: drive or on your desktop)

E) Remove any desktop shortcuts to anything bot-related. No desktop shortcut to the bot or even the bot folder! You will need to “dig” for the bot when you want it.

F) Rename the bot itself (holdembot.exe) to something like MSOUTLOOK.exe or skype.exe. Do not rename anything else in the bot folder!

Important: If you rename the bot file from holdembot.exe to something else, you will then need to always open the bot to Run as administrator each time you open it. This can be done from the mouse right-click menu on the program icon, or you can set the properties so it always opens that way.
1.5 Sitting in a Game and Starting the Bot

To open the bot just double-click on the program icon titled holdembot (or Holdembot.exe). If running Vista, you must run the bot “as administrator.” Do this by right-clicking on the icon and choosing Run as Administrator from the mouse menu.

The default playing profile loads automatically from the holdem.ppl file, and you should get that confirmation message in the bot window when you first start it. To use a different profile, click on Holdem and then Read profile on the bot’s menu. A window will open showing the available profiles we included with the bot download. Simply click on one of them and then select Open. (We’d recommend the 6pack profile for cash games, or the MTT profile for any tournament).

» Open the poker room software. Make sure you set it per section 1.3, above. Find a game and take a seat.

» Click on Auto-post blinds at the poker table. You may wish to wait for the big blind, but if you want to come in with a late position blind that is fine.

» Wait until you are clearly between hands before starting the bot (or before opening a second bot window, see section 1.6 below for multi-tabling instructions).

» Start the bot by clicking Start on the bot menu. You should then notice it reading the board cards as they are dealt. When it is your turn to act, the bot will instantly read your hole cards, position, number of opponents, stack sizes, and the entire situation before playing the hand for you according to your profile instructions – all within 2.5 seconds.

» Optional: Hide the bot window by clicking on Hide on the bot program menu. Before it vanishes from sight, it will give you the keyboard command for bringing it back (usually Alt+F10).

» Stop the bot by clicking Stop on the bot menu, or by setting one of the features on the bot that will stop it automatically by time, number of opponents, or what happens to your stack size.
1.4 Multi-Tabling

To play additional tables, first take a seat at your first new table and click auto-post blinds.

Then, on the open bot window, go to Holdem > New Window and go ahead and click on New Window. A second bot window will appear. Voila!

Choose a profile for the new bot window with the Read Profile function. This will not affect the profiles in use at any other open bot windows! Each bot window operates independently. So you can have the bot play an SNG with one profile at the same time it plays a cash game with a different profile.

Only one unhooked table can be open when you start the bot. It will automatically attach itself to whatever table is open that has no other bot window connected to it. There cannot be two poker tables open that do not have bot windows attached to them, or it won’t know which one to hook to. For this reason, you must open the tables, join them, and hook a bot window to them (by pressing start on a bot window) one at a time. Multiple bot windows can be opened in advance, however.

The Hide button hides all the bot windows at once. So, when multi-tabling, minimize the bot windows that are already attached first, and when you have started as many tables as you want, then hide all the bot windows at once.

Table Positioning Tip: You should generally try to position the tables so there is minimum overlap between them, as a best practice, before starting the next bot window. On smaller screens, at least position them so the betting fields and buttons do not overlap. That said, tables do not need to be visible for the bot to work, and they can all completely overlap if necessary.

If the bot cannot connect to the additional table on its own, it will ask you for the name of the new table. Be sure to spell it correctly and make sure you capitalize the right letters. Try to do this as quickly as possible.

Repeat the process for opening a third and fourth table if desired, to a maximum of 6 tables.

To stop: First quit the poker tables in the normal manner, before closing the poker room software. If the bot windows are hidden, bring them all back at once with the appropriate Alt+F command. Close the bot windows individually.

------------ Quick Start End -----------
2. Profiles

2.1 Using Different Profiles

Many alternative profiles targeting different game environments already exist for our Holdem Bot. We included several good ones with the bot download. Others can be discovered in our support forum.

In addition, you can make the bot play any way you want for any poker situation. There is a short learning curve for doing this, but it is not difficult.

The bot gets its playing instructions from one of four overriding “levels,” the top level which you can alter and customize to your heart’s content. User instructions for specific situations can be created and saved on a standard text file by using Notepad, the text editor that comes with Windows. These saved playing instructions are referred to as profiles. You don’t need any computer programming knowledge in order to make your own profile, or to tweak an existing profile to your liking. Just knowing basic poker terms is enough for most people to be able to do this, especially with our help and guidance in the forum.

There are two types of profile formats:

.ppl (a type of binary file)

.txt (text files, which is what Notepad files are).

A .ppl file started out as a .txt profile but was converted to the other format to protect the profile from being copied. You cannot open a .ppl file for viewing; only our software can access it. You can create and save profiles in .txt format, but you cannot convert them into .ppl unless you have us do it for you, or purchase the .ppl converter from us. (You don’t need to do this unless you plan on selling or sharing your profile and want to copyright-protect it.)

The default profile that came with the bot is in .ppl format (and has been named holdem.ppl so it auto-loads, as will be explained below). The only other way you are likely to get that type of profile is if you decide to purchase one from a reputable seller in the Marketplace section of our support forum. Most of the free
profiles in our forum, many of which are quite good, are text files that can be opened, viewed, and tweaked to your liking.

At any given time exactly one .ppl profile and one .txt profile can be loaded into the bot. No more. Either can be swapped out at will. Text file instructions are the top level and override everything. Commands from a .txt profile will, therefore, always be executed first, as that type of profile is read by the bot first.

The first matching command the bot finds is always executed. So .txt profile actions override any conflicting .ppl profile actions. This way it is easy for you to tweak a play here and there and save it as a short text profile.

Both types of profiles can be set to auto-load by default whenever you open a bot window. That is what the default profile that comes with the bot is set to do. To designate a profile as a default auto-load profile, all you have to do is rename it as follows:

.ppl file auto-load name: holdem.ppl

.txt file auto-load name: AutoProfileHoldem.txt

Any profile kept in the same folder as the bot that has the above name(s) will auto-load into the bot by default whenever you open a bot window. So you cannot have more than one of each file type with the above names, or it will create a conflict. If you have one of each profile types saved with the above names they will both auto-load. But remember, the .txt file instructions take precedence.

For the demo we recommend you use one of the profiles included in the download. If you are adventurous, you might decide to read a little of the PPL Guide and try tweaking an action or two during your 200 free hands, to get the feel of how customizing the bot’s actions works.

2.2 Creating (or Tweaking) Your Own Profile

In order to customize the bot’s playing instructions, you first need to understand how the existing programming works. There are four levels in the bot where playing instructions come from, and each higher level overrides the next lower level. They are:

1. Root-level programming (lowest level)
2. Option Settings on the Bot Menu
3. Any .ppl profile that is loaded
4. Any .txt profile that is loaded (highest level)

The root level programming lies at the core. This is the original bot that we started selling in 2006, before it was improved 100 times, and before it became
user-configurable. It actually plays decent poker to this day, and some actions in the current default profile are still referred to it.

The **option settings** on the bot's main menu are the second level. These were originally developed to start allowing user control of the bot’s actions. They are explained individually further in this manual. The thing to understand about these is that adjusting the option settings on the bot will only affect actions that are referred to the original root level programming. If you want to create a profile just from the bot’s option menu settings, you can still do that. But you will need to disable all other profiles from loading (because the instructions in them will override the option settings, so you need to rename or remove the default *holdem.ppl* profile that is set to auto-load in the bot folder). This is still a viable way to make your own profile, however, especially for tournaments.

Profiles that consist solely of option menu settings can be manually saved as a text profile directly from the bot, and loaded again by using the menu items:

- **Holdem > Write Profile**
- **Holdem > Read Profile**

*Write Profile* is used to save them and *Read Profile* is used to load them. Profiles are saved as a simple text file, and then can be edited in Notepad. You can also add your own custom instructions to any saved profile (or any existing text profile) by writing them in PPL underneath the saved option settings. PPL is the easy Poker Programming Language any poker player can learn in about an hour with no coding background needed – see the *PPL Guide* that came with the bot download.

The default path for saving and loading the profiles into the bot is the same folder where the rest of your bot program files are located, which should be at C:Poker\data if you did not move it. (On your **C: drive** in a folder titled **Poker** and then further inside a subfolder titled **data**).

**Profiles in .ppl format** are the third level that the bot gets it’s instructions from. Remember, these are just a saved text profile that has been converted into this format. You don’t need to be concerned about this (other than the fact that the default profile which comes with the bot is in this format) unless you are downloading profiles in this format from our support forum.

**Profiles in .txt format** are the fourth level, and top level. Instructions from text profiles override everything. That way you can load a text profile with just a few lines of PPL code which will tweak a few actions here and there from the .ppl profile that you have loaded. (This is exactly what the four text profiles that came in the bot download do, as they simply tweak the default playing profile which auto-loads in .ppl format.) Tweaking actions from the default profile in this manner is a great way to start making your own profile!
Within a saved profile there can be both saved option settings and PPL coding. The PPL coding starts with the word “custom.” Some text profiles in our forum do not bother with the bot’s option settings. These will always start with the word custom on one line at the top of the profile. Profiles with saved option settings, by contrast, will have those settings saved above the word custom, like this:

```
PPL Coding starts here
```

```
37 FoldOrGoAllInWhenOpponentsAfterFoldsLessThanStackSize = 1000000
38 ApplyFoldOrGoAllInAfter = 0
39 FoldOrGoAllInWhenOpponentsAtTableLessThan = 5
40 FoldOrGoAllInWhenOpponentsAtTableLessThanStackSize = 1000000
41 AlwaysCallWhenOpponentsRaiseISLessThan = 4
42 AlwaysCallWhenStackSizeIsLessThanTotalInvested = 90
43 Verbose = ON
44 AutoPlay = ON
45 UserDefinedGameType = 0
46 UseOCRAAtFullTilt = OFF
47 AutoRebuyAtUB = ON
48 AlwaysAskForTableName = OFF
49 DefaultBetSizeFlop = 100
50 DefaultBetSizeTurn = 75
51 DefaultBetSizeRiver = 60
52
53 custom
54 // MTT Kit + Doodle 106
55 preflop
56
57 when bigblindsize >= 1000 and (raises = 1 or botslastaction = raise) and stacksize < 30 and (hand = QQ or hand = JJ) raisemax force
58
59 when stacksize > 100 and raises >= 1 and betsizex > 12 and not (hand = AA or hand = KK or hand = QQ or hand = AK or opponentisallin or opponentsatatable <= 3) fold force
```

PPL coding always overrides the saved options settings. So PPL code in a text profile is always at the top level and that is the best way to start tweaking your own profile. This can be very simple, something like:

```
preflop
when (hand = AA or hand = KK) and raises >= 1 raisemax force
```
...which tells your bot to raise all-in with pocket aces or pocket kings whenever somebody else raises. All of PPL language is simple and intuitive like this, so do give the PPL Guide a read to start learning how to customize your own actions.

The default profile that comes in the bot is called the “Doodle” profile, and is available as a text profile as well. It is designed for full 9 or 10 player cash games. If you would like the text profile version of it, the latest version can always be accessed at:

www.bonusbots.com/doodle.txt

There is also an MTT version of the Doodle, which has been altered for optimal tournament play. This was included in the bot download as an alternative profile and is simply titled MTT (or MTT.txt).

Some profiles are simply tweaks of other profiles, while others are complete and self-contained. It is difficult to define every possible poker situation (it took us two years to do that). Therefore most profiles, even fairly detailed ones, still use the original root level programming as a safety net. Many simply tweak the default Doodle profile.

To summarize, there are three practical methods of customizing profiles for use in different game types.

1. Make changes to the quick-settings located on the Option Menu of the bot. Many decent profiles have been created with this method, and in fact at least one tournament profile used by our forum members is of this type and contains no PPL- coding whatsoever. It has made plenty of high-money finishes in large-field MTT’s including some firsts, completely unassisted. Just remember that option settings do not override PPL commands. So if you are making these option setting adjustments when you have a profile loaded that uses PPL code, the settings may not take effect in every situation you want them to.

2. Add some custom code to your saved profile by learning PPL, the easy Poker Programming Language that puts you in total control. All of the bot’s actions can be 100% user-configured in this manner, and it’s easy to use. If you are tweaking a profile that uses PPL, this is the only reliable way to get your desired actions to always occur. See the PPL Guide that was included with your download (and is therefore located in the same folder as the bot at C: Poker / Data) for more information.

3. Simply use an existing profile that someone else created. There are several good ones included in your download, and new ones can be found in our forum.
2.3 Changing Profiles in the Bot

Profiles can be loaded into the bot either automatically or manually. But before you can load a profile, you first must save it and place it in the bot directory. This can be a tad tricky if you have never worked with a text editor like Notepad before, so let’s make sure you are saving the profile properly.

Notepad vs. Enhanced Text Editors

If you plan on tweaking your own profile using PPL, we highly recommend downloading Notepad 2, an enhanced text editor greatly superior to the original Notepad program that comes in Windows. This is an open-source (free) program, so just Google it.

One of the nice things about Notepad 2 is it displays the codelines on the left side, so you don’t have to search for them (also, original Notepad will sometimes misreference codelines). You can see the difference here:

Notepad 2 is on the right above. It has many advanced features, and displays the codelines in red on the left side.

There is a critical difference between these two programs, which you need to be aware of, when it comes to saving profiles. Original Notepad will automatically assign an invisible .txt extension to the file type when saving a text profile. This means you must not add a .txt extension to the file name when saving it from Notepad! If you do, the bot will not find it when you try to load it because it will actually have two .txt extensions, though only one is visible. (If you’ve done this,
you can fix it by right-clicking the file, choosing Replace, and then removing the last .txt extension).

So when saving a profile from original Notepad, just name the file, without a .txt extension, like this:
Notepad 2, however, does not automatically add the .txt extension when saving the file. So if you are using Notepad 2, you need to include it when naming the file, like this:

![Notepad 2 interface showing file name and save options]

**Automatically Loading Profiles**

If you have a text profile you want to automatically load into every bot window that opens, simply name it **AutoprofileHoldem.txt** (do not include the .txt if naming it in original Notepad). Place it in the bot directory and it will always auto-load.
Manually Loading Profiles

To manually load a profile: On the bot menu first click on Holdem and then on Read Profile.

A window will open showing the available profile modifications we included in the download. For the demo, we suggest you select the text file named 6pack if you want an aggressive cash game profile, or the file named MTT if you want a smart tournament profile. Then select Open at the bottom of the window to load it in the bot. If you want a tighter cash game profile, skip this entire step and do not load a profile at all (as the holdem.ppl profile will automatically play by default, and it is more conservative).
Your profile is now loaded as you can verify from the confirmation message in the bot that the profile was read.

Whichever way you load your profile, remember it must first be located in the bot directory with the bot (which should be at C:Poker\data if you didn’t move it).

**Copying and Saving Profiles Using Notepad**

This is the procedure for copying a profile from our forum and properly saving it (using Notepad) in the bot folder for use.

1. Open the profile. Copy the code. Make sure you get all of it! A good way to do this is by first right-clicking on the profile and then clicking on Select All before clicking on Copy

2. Paste into a blank Notepad (Start > All Programs > Accessories > Notepad) You can right-click the mouse now and choose Paste

3. Save As ‘whatever’ and move into your bot folder (inside C:Poker\data if you did not move the location)

4. Load in the bot by going to Holdem > Read Profile and browsing for it

**Alternative to Step 4:**

A) Save the text file as AutoProfileHoldem and it will load automatically as the default profile every time you open a bot window

Do not add a .txt extension to the profile name when saving it from original Notepad that comes in Windows! Do add the .txt extension, however, if saving it from Notepad 2.
Confirmation of Profile Loading

The bot will give you a message in the bot window confirming the profile was “read” if it was loaded successfully. If not, it will give you a message explaining why it was rejected (usually because the bot cannot find the profile, or there was a PPL typo in the profile). Please look for the confirmation or rejection message each time you load a profile, regardless of which method you use to load it.

*If you get a message in the bot window that the profile was read, then it stays loaded!* This *doesn’t* mean all the messages in the bot window will now come from the profile that is loaded, however. Please note the default .ppl profile and/or original root level programming are both still in the background, and will still give messages saying what they *would* do in many situations before the top-level profile is even consulted for the situation. Pay attention to the actions taken in the bot messages. When you see a *user defined condition* being executed, referencing a codeline, that action is from the text profile that is loaded. Also, many profiles still do defer some actions to the default profile, and even to the root level programming (which is affected by option menu settings).

Auto-changing a Profile Mid-session

You can have the bot automatically switch to a different saved profile in the middle of a session. This can be triggered when the table gets short-handed, when a specified number of hands are played in the current session, when a specified number of minutes are played in the current session, or when your stack size falls below a certain level. To set this up go to:

*Holdem: Auto Read Profile*

...and enter the profile file name, and choose which condition you want for changing to that profile. The bot will give a confirmation message if you do this correctly. If you don’t get the confirmation message, you probably need to include the .txt extension in the profile name in the auto-read field.
Profile Info on the Included Profiles

Here is some info on how the profiles that come in the bot play:

**6-Pack:** Load this one for 6-max cash tables. It plays a LAG-style game (loose-aggressive) without becoming hyper-aggressive. Buy in for a full stack.

**Little Green:** Based on the style taught in Phil Gordon's book, this profile will push with draws and strong hands on the flop, so is best used in cash games and is good at full 9/10 player tables that have low player turnover, because we want them to see when we push with a draw and go on tilt when we make it. Buy in for around 70% of a full stack for best results.

**Wild Bill:** A hyper-aggressive cash game profile that tightens up when its stack size reaches 150 big blinds. It is important to only buy in for a half-stack with this profile (you can also short-stack with it).

**MTT:** One of our favorite tournament profiles. Use in MTTs or SNGs (but be aware that 200 hands may not be enough to finish the event if you are still running the demo).

**Default profile:** Do nothing to use this one as it loads by default. Its name is Doodle and it plays a typical TAG-style (tight-aggressive) so is best at low stakes, full 9 or 10-player cash tables. A good choice to simply evaluate how the bot functions if you can find a full 9/10-max table going.

**xTestOnly:** Use this one only to test the bot functions, to make sure your settings are correct so the bot can bet and raise. When this profile is loaded it will make the first bet or raise at every opportunity prefflop and on the flop. After seeing that the bot is working right, switch to another profile! (Unless you are in a crazy game at PPpoker in which case this profile may actually win.)
3. Detailed Instructions for Holdem Bot

Thank you for taking the time to look at our program! We hope you enjoy it, and that you decide to use it to help in your online poker adventures.

3.1 Run Bot as Administrator (Vista only)

This is largely outdated. The only exception is if you are using Vista for some odd reason, in which case you need to run the bot As Administrator. Right click on the bot icon and select the Run as Administrator to open the bot, each time. It is no longer necessary to run poker room software as administrator, on any system.

3.2 Seat Position

At poker rooms which sit you in the bottom center position by default, you must remain in this seat position and not change even if the poker room allows you to change the display so that you appear in a different seat. But please also refer to the individual poker room instructions in this manual for proper seating configuration for each site.

3.3 Free Trial Notes

Your free demo is good for 200 hands and is mandatory prior to license purchase. You don't have to exhaust the full 200 hands, but you do have to run it for a bit. Use the trial to get the bot working properly on the site you plan on using it at, and play with some of the features.

After you have run the bot, it will establish a Computer ID number, which can be obtained by choosing the bot menu item Holdem > Get Computer ID. If you exhaust the 200 free hands, this number will also appear in the last playing session log file that the bot records. We will need this Computer ID number when you purchase your license.
3.4 Where to Put the Program

The installation program places a shortcut to the bot on your desktop by default. The files are actually installed in a folder at C:\poker\data (unless you specified a different path). You can access the bot folder quickly by right-clicking on the Holdem Bot shortcut and selecting *Open File Location*.

Please do not move the bot, or any of the profiles or program files, from the bot folder. They all need to be kept in the same directory. If you want to move the folder and/or rename it that is fine, but keep all the files together in it.

3.5 Session Log

The bot records a log of every hand played. This is a text file that is automatically created and saved in the folder with all the other bot program files. The session log is simply named *holdem*, or *holdem.log*. Each time you open the bot, the previous session is erased from the log and overwritten with the new session.

When you use the multi-table function, multiple session logs are created, one for each table or tournament being played. These are named *holdem2, holdem3, etc.*. They are overwritten just like the 1-table log the next time you have two or three tables going.

The normal session logs recorded in the bot folder are created on a delay and will not fully complete until the corresponding bot window is closed. You can instead opt to produce a **real-time session log** to a location of your choosing, such as your desktop. When this option is enabled it is in lieu of the normal session log, so the usual delayed log created in the bot folder will not be produced. This feature may be handy for copying out hands you observe before they get buried in the log.

3.6 Which Games to Play

The bot supports all game types including heads-up tables, single table SNG’s, and all forms of multi-table tournaments (MTT’s). In MTT’s the bot will follow the table changes for you as long as you don’t have an unhooked table open at the time of the table change, or experience interference issues from other programs or web browsers open. It is not recommended to multi-table while using the bot in an MTT unless you are around to check on your tables frequently, due to the higher chance of not following a table change if two occur at the same time.

High stakes cash games and 1-table SNG’s are difficult to beat with or without a bot. Most poker-botters stick to lower stakes when it comes to cash games and 1-table SNG’s. If you want to bot higher stakes, MTT’s are the way to do it - as strategy is not very different in a high stakes MTT than at a low stakes one.
3.7 Hiding the Bot

The second to last item across on the main bot menu is *Hide*. This causes all open bot windows to vanish from your computer screen completely, but they will keep playing for you while invisible. While in hide mode the bot not visible to screen scraping programs, and will not show as an application running on your system either.

Before the bot hides itself, it will check your system for the availability of the last six F-command keys on your keyboard to use for calling it back. For most users it will start at F10, but if you have another program which uses F10 it will move on to F11 -- and if that is also unavailable, it will finally try using F12. The order after that is F7, F8, and F9. Before the bot windows vanish a small popup window will appear telling you which key command to use in calling them back, and you must acknowledge this by clicking OK before the bot will hide.

To call it back, you must hold down the ALT key on your keyboard while pressing the F10, F11, F12, F7, F8, or F9 key (whichever one the program told you to use before hiding).

When multi-tabling, it is probably easiest to minimize the connected bot windows. After all the tables you want to play are connected, you can then use the Hide function to hide them all.

**Tip:** Most of us don’t bother to hide the bot these days. If a poker site really wants to hunt for it, we can’t stop them. Sites don’t bother scraping for bots any more, either. The only site we ever have an occasional issue with is 888, and that is likely from other players turning in suspected bots by behavior observation.

Please note that if you forget to call the bot back from hiding after a session, the hidden window will come back up when you try to start the bot again.

3.8 Game Type Menu

You will notice a menu item for the *Game Type* on the main bot menu, which can be used to tell the bot the limit-type of the game it is playing. You should leave this on *Auto-detect* unless the bot has a problem determining the limit-type. It shouldn’t matter anyway, as 99% of the games played these days are No-Limit and that is what the bot expects to be playing.

3.9 Options Menu

The bot includes many playing options that you, the user, can set. These are found on the main bot menu by clicking on *Options*. You will notice the choices are organized into logical sub-menus. Not all of these settings will override profile
instructions, however, so be sure to read **Section 2** of this manual so you understand how profile instructions work.

**Options Settings Which Always Work**

The following option settings override profile instructions, so will always work.

**Sit-out Options**

This group of options allow you to tell the bot to quit playing after a certain amount of time, certain number of hands, when your stack size grows to a certain level, or when the number of opponents at your table shrinks to a certain number. In the case of the *opponent count*, the bot will **sit back in** when the opponent count grows back to the number you select here (unlike the PPL sit-out command, which is permanent). All other sit-out commands on this menu are permanent sit-outs, except for the bathroom break.

**Bathroom Break Setting** *(Under Sit-out Options)*

You should set the bot to take breaks in cash games. The purpose is to mimic being human. You can set the interval and the time of the break. The shortest allowed break time is 2 minutes. It is not recommended to take breaks longer than 4 minutes as you are likely to get removed from the table. A good setting for cash games is 3 minutes every 40-120 minutes.

If you do not want the bot to take a bathroom break, such as when you are playing in a tournament, simply set the interval to 900 minutes.

**Max Players Allowed at Table**

This option only exists to let you manually tell the bot what table type you are on, in case it is having trouble auto-detecting the player count. If you are sitting at a 6-max table, for example, and notice the player count occasionally saying 7 or 8, try setting this to 6. The bot will then know the correct opponent count by combining this setting with the fold count when it is your turn to act.

**Log to File**

You can output a **real-time session log**, a text file that records everything you see reported in the bot window, to a location of your choosing such as your desktop. When this option is enabled it is **in lieu of** the normal session log, so the usual (delayed) session log created in the bot folder will not be produced. This feature may be handy for copying out hands you observe before they get buried in the log.
Other Settings

Occasionally we put a “poker country switch” on this menu to tell the bot which poker client you are using if there are differences in them between countries. You should check with us in our forum or by email before setting one of these to see if it is currently needed.

Options Settings Which Do Not Always Work (because they are overridden by profile instructions, see Section 2)

Stack Size Recognition Note

Our Holdem Bot bot reads its stack size and incorporates that into several of the option settings. This is useful for playing a more aggressive game with a short stack (especially in tournaments) and calling raises after your bet pot-commits you.

Stack size is set by the number of big blinds on the option menu. You will notice that it is read from the screen in dollar amounts, however, and recorded that way in the session log. Don’t be concerned about this - the bot makes the appropriate conversion in its calculations.

Total Investment Note

The bots keeps track of how much it has invested in any given hand. There is at least one option where you can adjust a setting by the bot’s total investment. This is useful for making sure the bot never folds when you are pot-committed.

Aggressive Play Settings

On the Aggressive Play Settings submenu you will find two different option settings for adjusting the standard bet and raise sizes that the bot will make when acting from its default programming.

The preflop setting allows you to tell it when you want to make pot-sized raises preflop, based on a variety of factors including some random elements. The default programming of the bot will make pot-sized preflop raises sometimes and min-raises sometimes. You can adjust that here.

The post-flop setting allows you to enter a % number (which corresponds to % of existing potsize) for changing the bot’s standard bet and raise size on the Flop, Turn, and River. For example you might tell it to bet 100% on the flop (that is a pot-sized bet), 75% of the pot on the Turn, and 60% of the pot on the River.

When a custom bet size other than 100% is chosen the bot will actually type in the betsize and click Bet. When 100% is chosen it will use the pot button to bet or raise the pot.
When 0 is chosen the bot will use its lowest level of default programming, which is to bet the pot on the flop and if a half-pot button is available use that on the Turn and River, otherwise bet the pot and the Turn and River as well. The default settings for this option are 100 on the flop and 0 on the Turn and River so you should adjust them to your liking if you don't want pot-sized post-flop bets.

FOLD OR GO ALL IN OPTIONS

On the option menu you will find two Fold or Go All-In settings, for NL and PL type games. These can be set to ALWAYS, invoked by number of opponents, or by number of hands played in the session. When either of these settings are triggered the bot will still check and fold as normal, but when it's action is to call or raise it will attempt to go all-in. (This includes all programmed blind-stealing and bluffing situations.)

Please make sure both of these options are set on default in game environments where you do not want the bot to push all-in. Setting them on default turns them off so the bot will play as normal.

Also, please see the Aggressive Tournament Setting further below which also allows you to set conditions for pushing all-in, both preflop and post-flop, based on certain conditions. The two Fold or All In settings are best for when you are at the end of a tournament or have a short stack in a tournament.

You can use either of these settings in conjunction with the Super Tight option as well. That would have the bot waiting for premium hands and pushing all-in whenever it has one.

The difference in the two settings is how they are triggered.

FOLD OR GO ALL IN WHEN OPPONENTS (AFTER FOLDS) LESS THAN...

This setting is triggered by the remaining opponents in any particular hand. That could happen any time regardless of how many players are sitting at the table, as long as the set number of hands have elapsed in the session. It's a good choice if you want to play the "Kill Phil" style of poker in a tournament. Note that the bot might push all-in on the first hand dealt using this option if you don't apply it after a set number of hands.

You can also choose to have this setting invoked only when your stack size falls below a certain level. However please note that the active number of players in the hand must still be below your chosen number for this setting to trigger, even when your stack is small.
FOLD OR GO ALL IN WHEN OPPONENTS AT TABLE LESS THAN...

This setting is only triggered by the original number of opponents sitting at the table. So if you have it set to less than 4, as soon as the number of opponents are 3 or less the bot will always push all-in when it plays. This is a good choice for finishing SitnGo's and Tournaments.

You can also choose to have this setting invoked only when your stack size falls below a certain level. However please note that the number of players sitting at the table must still be below your chosen number for this setting to trigger, even when your stack is small.

**PLEASE NEVER SET BOTH OF THE FOLD OR GO ALL IN OPTIONS TO TRIGGER. CHOOSE ONE OF THEM IF YOU ARE GOING TO USE THIS FEATURE, OR BETTER YET USE THE AGGRESSIVE TOURNAMENT SETTING INSTEAD**

ALWAYS CALL WHEN OPPONENTS RAISE IS BELOW

This is another setting on the user option menu that applies only to NL and PL games. It's purpose is to keep the bot from folding to small raises by your opponent when it would be foolish from a pot odds standpoint to do so. On the river there is a hand value qualifier of best kicker or better for this setting to be invoked; however on all other streets there is no hand strength qualifier.

There are two parts to it: One for measuring the opponent's raise against your bet size, and one for measuring the bot's total investment in the hand.

There are three positions available for measuring the opponent's raise size: 20%, 30%, and 40%. Most players prefer the 40% option in most game environments. So that means whenever you bet and somebody raises but the raise is less than 40% of the amount you bet the bot will automatically call. (If you are playing high-stakes cash games you might prefer a lower setting for the bet size portion.)

These settings also apply to an opponent attempting to sandbag you by calling your bet when they only have a few chips left and then betting their last few chips out on the next round. The bot will remember that it was the last bettor or raiser on the previous betting round in this case and apply the same settings you have chosen.

The second part is a setting for always calling when your current stack size is below a certain percentage of your total investment in the hand. The default setting is quite low and we recommend setting it much higher - probably at least 75% - especially for tournaments. Otherwise the bot might fold for a raise with one pair hands when you want to call.
The two settings in this window protect you against folding when you have invested so much in the hand that folding would be undesirable. So if you bet say $1200 in chips in a tournament and somebody with only $1400 chips raises all-in the bot will call. Or if somebody raises large and you only have $200 left in chips after making that same $1200 bet the bot will call. Or if you bet $1200 and get a call from a player who only has $200 in chips left after he calls and he acts first on the next betting round and bets his last $200 out the bot will also call, regardless of what card hit the board.

MINIMUM BET OVERRIDE

This affects post-flop play in No Limit and Pot Limit games only. This option lets you decide how you want to deal with knuckleheads who make a minimum bet of only 1 big blind. Please note that the selected action will only take place if the pot size is at least 5 big blinds and your hand value is best high-card or better.

NO LIMP

This option will stop the bot from just calling preflop (unless it has already raised). It affects all positions except the Big Blind, and works in Limit games as well as NL/PL. You can choose how you want to handle the relatively few hands that the bot would normally limp in with: Raise instead, Fold instead, or Raise sometimes and fold the rest of the time based on various factors. Some players prefer to play this way in cash games, especially at the 6-max tables.

AGGRESSIVE TOURNAMENT SETTING

Near the bottom of the option menu you will find the Aggressive Tournament option. It is highly recommended that this option be used for all types of tournaments. These particular option choices define conditions for having the bot use the Bet Max button - in other words, shoving all-in.

There are two sections, one for preflop play and one for post-flop play. One choice must be made for each section. The default position for both is off, so you will need to make a choice for turning them on in tournaments.

The preflop section gives you specific hand lists to choose from. Note that the first choice consists of only the top hands and also requires that there be a preflop raise before the bot will go all-in. The rest of the choices loosen the hand selection up progressively and do not require a preflop raise before raising all-in.

The post-flop conditions are not defined for the user. We have programmed what we believe are the best post-flop conditions for shoving in tournaments. These include top pair or better on non-scary boards and reasonably strong hands on scarier boards. But you still must choose whether you want this option on, off, or only on if there was a preflop raise (which is the first choice on the menu).
You can also choose to have either or both sections only invoked when your stack size falls below a certain level. This is a great way to play tournaments, pushing all-in with any reasonable hand when your stack is short.

We highly recommend starting MTT’s with the post-flop aggressive tournament option triggered when there was a preflop raise only, and the first preflop option checked which contains only the top hands and also requires a preflop raise. As the tournament progresses it is often wise to loosen both of these up.

The aggressive tournament setting options can also be quite effective in the lowest-stakes cash games, especially the post-flop setting.

MINING FOR SETS

A highly recommended setting for cash games and the early stages of tournaments. This option will make sure the bot always calls preflop with pocket pairs 99 and under, and allows you to set the maximum size raise you will call for. A good general setting is under 5 big blinds.

Tighter Play Settings

SUPER TIGHT PLAY OPTION

When this is checked the bot will fold all hands preflop except: AA, KK, QQ, JJ, 10-10, 9-9, AKs, AK, AQs, AQ, AJs, and KQs. These it will play as normal. This setting affects Limit play as well as NL/PL. Note that if you also have the Fold or All In setting invoked, it will just go all-in whenever it gets one of these hands and fold the rest of the time.

Using this setting robs you of the sophisticated programming that has gone into this poker bot. However some people like to play SNG’s this way, and also if you just want the bot to play super tight for the first couple hours of a tournament this would be the way to go. (There are other creative uses for it as well.)

SEMI-SUPER TIGHT PLAY OPTION

The same setting as Super-tight above but also includes all pocket pairs. In NL games the bot will call preflop raises up to 3 big blinds in size with 66 and below and up to 5 big blinds in size with 77 and 88.

To call larger size preflop raises with these same small pocket pairs you can use the Set Mining option (below) in conjunction with this setting.
**POST-FLOP IN BLINDS OVERRIDE**

When you are in either blind position preflop you can tell the bot to only play good hands post-flop, starting with Top-pair third best kicker or higher. It is a tight setting that rocks love. The setting is only invoked if there was no preflop raise, in other words you got a free look at the flop and have nothing invested. This works for both Limit games and NL/PL.

**PREFLOP RERAISE OVERRIDE**

You can check this setting on or off. It only applies to situations where an opponent has raised preflop. When checked, the bot will only reraise with AA or KK and just call with all the other hands it might normally reraise with. This works for both Limit games and NL/PL.

**DISABLE SPEED FOLDING**

By default the bot will speed-fold the weaker starting hands automatically in speed poker games, which means it will not attempt to steal blinds with them in late position, being as it does not evaluate position until it is the bot’s turn to act. Speed-folding can be disabled on the bot’s option menu under Options > Other Options > Disable Speed Folding if you wish to steal blinds instead. It will slow the pace of the game some, but not too much since most of the speed comes from not seeing the flop and having to wait for opponents to play out a hand.

**3.10 Saving Profiles**

Once you go through and choose all the options you want, above, for a certain game environment, you can save them as a profile. That way you can get them all back quickly without having to set them all again.

To save a profile, click on the first item on the main menu *Holdem* and then on *Write Profile*

A window will appear with the default name "holdem_profile.txt"

If you only want to save one profile you may as well call it that, as this is the default profile name for both saving and loading profiles. However most players will want to save at least several profiles, in which case you need to rename them.

For example, c for cash games (save as ‘c’ load as ‘c.txt’), or s for 1-table SNG's, m1 for the beginning of tournaments, and m2 for when you notice you are short-stacked in a tournament.

To load a saved profile, go to *Holdem: Read Profile...*
...then browse to the profile you want to load, select it, and click **Open**.

Please note that profiles saved by the bot are saved by default in the same folder/directory where the bot program is kept. This makes loading them easy as the bot looks for them in that location. Alternatively, you could save them somewhere else by specifying the path - but of course you will need to specify the path to load it as well. For example: C:\cash6max.txt.

### 3.11 Switching Profiles Mid-Session

You can have the bot automatically switch to a different saved profile when the table gets short-handed, when a specified number of hands are played in the current session, when a specified number of minutes are played in the current session, or when your stack size falls below a certain level. To set this up go to:

**Holdem: Auto Read Profile**

...and enter the profile file name and choose which condition you want for changing to that profile.

### 3.12 Custom Coding Profiles With PPL

Our poker bots support user custom profile programming, in addition to the settings on the option menu, for those wanting more control of play. This feature will allow you to completely program all of the bot’s decisions yourself. The process is easy to learn and it has resulted in the creation of a marketplace where users of our poker bots trade their custom profiles with each other. If you are interested in this please read the [PPL User Guide](#), a pdf file that you should have received with the bot download and, therefore, can be found in the bot directory with all the other bot files on your PC.

### 3.13 Setting Your Own Default Profile

There is an additional feature that will allow you to have a certain profile be the default profile that every bot window will use without having to load a profile at all. All you need to do is save whichever profile you want for the default profile as:

**AutoProfileHoldem.txt**

…in the same folder as the bot. When a text file titled **AutoProfileHoldem** is detected in the bot folder, it will load automatically into every bot window you open. You would then need to load a different profile only for the tables that you want to use a different profile at.
3.14 Multi-Tabling

You can currently bot **up to six tables** at a time on all our supported poker rooms (any exceptions are set by the poker site, not by us). Even with small monitors and overlapping tables, you shouldn't have any trouble.

**Table Positioning Tip:** You should generally try to position the tables so there is minimum overlap between them, as a best practice, before starting the next bot window. On smaller screens, at least position them so the betting fields and buttons do not overlap. That said, tables do not need to be visible for the bot to work, and they **can** all completely overlap if necessary. Do keep some space between the edges of the tables and the edge of your screen.

If the bot cannot connect to the additional table on its own, it will ask you for the name of the new table. Be sure to spell it correctly and make sure you capitalize the right letters. Try to do this as quickly as possible.

Repeat the process for opening a third and fourth table if desired, to a maximum of **6 tables**. How many tables you can play before suffering a performance lapse depends somewhat on the poker room, your monitor size, and the configuration of your PC system. Most people can play at least three or four tables.

Multi-tabling is accomplished by opening multiple bot windows and hooking them to each table, one table at a time. Here is the procedure:

Get into the first table as normal and start the bot, but don't hide it yet. Instead, get into a second table and separate it as much as possible from the first table on your screen (without moving any part of it beyond the edge of your monitor). Then, on the bot's main menu go to:

**Holdem > New Window**

This opens an additional bot window which operates independently. You can now minimize the first bot window if you like. When you press start on the second bot window it should connect to the new table -- on occasion, it may ask you for the table (or tournament) name. This is case sensitive. It will then connect and you can repeat this process for additional tables if you like. After connecting to as many tables as you like, if you wish to hide the bots click **Hide** on any of the bot windows and they will all go into hiding.

Each window operates independently so you can play different game types with different profiles loaded in each window. **You cannot, however, multi-table between poker rooms.** All your tables need to be at the same room.

Please note that the bot handles table changes in MTT's automatically at all the poker rooms and does not need you to be there to enter the new table number as you do when opening a new bot window for multi-tabling. That said, we do not recommend multi-tabling MTT's with the bot unless you are going to be able to
semi-monitor the computer. This is because if you have a table change at more than one event at the same time, both bot windows may stay disconnected as you will then have multiple unconnected tables open.

### 3.15 Waiting for a Table

The bot has a function to wait for a table to appear before starting to play. This option will appear if you click Start on the bot and it cannot find a poker table window to hook itself to. It is useful for registering for tournaments and SNG’s early, before they start, so you can set the bot to play in them and just walk away.

Please note that the tournament must be a type where you are seated automatically, that is the table appears with you in your seat already when it starts. At some tournaments on some sites we must wait and click on a popup window to take our seat, so this feature will not work at those. How well this feature works depends on which poker room you are playing at, which type of tournament you are playing, and your individual PC setup. So please experiment with it before trusting it to start playing for you.

**Please Note:** You cannot wait for multiple tables and therefore should use this feature only to play one table at a time. Please do not attempt to play multiple tournaments using this feature.
4. Running the Program

See Section 1: Quick Start for complete instructions on setting up and using the Holdem Bot, including the necessary Poker Room settings.

**Performance Tip:** Don't check email or do other stuff while the bot is running. Have all your browser windows closed. Especially don't have a browser window open at any kind of poker site as the bot can get confused.

**Stealth Tip:** Don't run the bot for more than 12 hours at a time. This could flag your account to other players and/or the poker room as a possible bot.

5. Miscellaneous

**Taking a Screenshot:** There is a built-in Take Screenshot button on the bot. When pressed, this function saves the current screen image, in addition to a completed output copy of the current log, to the bot folder. The image is a special file type which won't open on most PCs, but is reviewable by our developer. If you wish to view the image yourself, you can download a free app called Irfanview here:

http://www.irfanview.com/main_download_engl.htm

If you are having any kind of issues with the bot, click the Take Screenshot button (when the problem is on screen) and email the image + log to us.

**Rakeback and/or bonus clearing** is usually necessary to show a worthwhile long-term profit in cash games. If you don't have a bonus or rakeback going for you, you should probably only bot tournaments.

You can get rakeback through our favorite provider at: https://tinyurl.com/b3jrz4
Poker Bot Strategy

A guide for optimizing the profitability of your bankroll

Introduction

Please Note: This strategy guide is now quite a few years old and parts are probably a little outdated. It still may be a good idea to give it a read.

Hopefully, the reason you have this guide is because you downloaded one of our poker bots. If not, please go do so at www.BonusBots.com. The download is free and will work for 200 hands before requiring a license purchase.

The purpose of this strategy section is to help you use our product profitably, in a manner that both suits you and makes the endeavor worth your while. We believe we are selling the best pokerbots on the internet, but if you don’t use them correctly they might not do you any good (other than having a really cool toy).

We have been selling an Omaha/8 bot since late 2006 when we started selling online gaming bots. In early 2007 it became clear that the real demand was for a Hold’em bot, as that’s where all the action is in online poker. So we started building one. This project proved to be much bigger than we ever could have anticipated.

One year later, we finally released it. And it’s not like we dilly-dallied on this thing either. It took a year of constant development, testing, and revising before we had something we thought was good enough to sell. Our Hold’em bot is the cumulative result of an incredible effort like you can’t even imagine. That was in the spring of 2008.

Fast-forward another year to spring of 2009. The original released product, while very good, has been constantly improved. To the point even of a special programming language being added to it which allows the user to control 100% of it’s actions if they so desire. Custom profiles are being cranked out by our users and posted in our support forum on a daily basis.

This bot takes previous round betting action into some of its playing decisions. It knows how many players are still in the hand, and what its current position is. It makes wise continuation bets and check-raises in good spots.

It also randomizes many of its decisions by using card colors. For example, the bot may raise or fold in some places depending on whether it’s first hole card is black or red. You simply won’t find these kinds of features programmed into other commercially-available poker bots. (Of course they didn’t take a year to create, either.)

As the product improves, the license fee rises. Consequently we see it as a very good investment, whenever you happen to purchase it.
Types of Poker Bots

There are three basic types of poker bots on the market.

Open Hold'Em

These are products that click the correct buttons but don’t know what to do. It’s for programmers, to give them a jump start and allow them to program the playing instructions. You need to know programming code to complete the product, C/C++ I believe. Poker rooms know about these and are actively scraping for them, so you need to combine the use of two PC’s in order to run them (one holds the Win Hold’em program, the other holds the poker room software). It’s rather complicated and involves a lot of effort to pursue.

Please note that our poker bots can now also be custom coded by the user, for those so inclined. So we are essentially offering the same thing now, except that our products come with winning programming already installed (in addition to a large option menu which lets you quickly adjust the play for many situations). Profiles are easily saved and little bits of custom code can be added to change the behavior here and there if you wish.

So a complete user-designed profile for our poker bots can now be created by anyone who has a mind to in a matter of hours, as opposed to a matter of months like it takes with Win Holdem or Open Holdem. Our language is very easy to learn even for people with no programming background. This is not necessary but is a nice extra feature. More about this below.

Third Party Brains

This category includes the OPI bots (OPI stands for Online Poker Inspector; or more specifically Online Hold’em inspector). The bot software uses a third party brain to make decisions, usually some type of poker odds software that gives playing advice based on the situation. The problem with these is that there are not enough variables in the poker advice programs to make a good bot.

Low limit games at certain poker rooms are full of these OPI bots. Our Hold’em bot will destroy them over time.

Self-contained Bots

That’s what our bots are. I have purchased a couple others that fit this category over the years, but they always turned out to be junk. I am unaware of any other product currently being sold in this category. They are, after all, quite difficult to create.
To run our bot you just open the program, choose your playing options, open the poker room, get in a game, click start and minimize the bot program.

**Staying in Stealth Mode**

Because it’s entirely possible that the poker rooms might start looking for our bot, it’s wise to always have it hidden while playing. It also might be prudent to have the poker room software open and maybe even the table you want to play at open for a couple minutes before joining.

Better yet, get into a game and play for a few minutes before opening the bot software and then quickly start and hide it. Have any settings from the option menu that you are using selected ahead of time. We really don’t anticipate any problems in this area but it’s wise to be careful.

When the program is in *Hide* mode it doesn’t show as an application running and is not visible anywhere on your computer screen. Use the Alt+F10 command to bring it back (or whichever F-key command the bot tells you to use before it hides). The software also incorporates several other stealth features to avoid being profiled as a bot, including:

- Random Pixel Clicking
- Random Delay Time Before Acting
- Using Preflop *Fold in Turn* Buttons sometimes (only at certain poker rooms)
- Very, very occasionally typing “nh” in the chat window when it loses on the river
- Scheduled Bathroom Breaks

Because of these features, it is extremely difficult to detect.

**Sit-out Options**

On the option menu of our pokerbot programs you can choose to have them sit out when the players at your table fall beneath a certain number. When the player count goes back to your selected number the bot will attempt to sit itself back in. This usually works, but not always. And it is very possible to get removed from the table by the poker room while sitting out.

For these reasons, plus the fact that our bots have been programmed to play well short-handed, we don’t recommend using this option for anything other than high-stakes cash games. Please make sure the sitout option is **set to <1** before using it the first time.

The sit-out option is automatically ignored in tournaments of all types.
Max Session Time

On the option menu of our pokerbots you can choose to have them quit after a certain number of hands or after a certain time has elapsed. This comes in handy when you are leaving for work or going to bed and want to control the playing session time, which is always a good idea (to keep from being profiled as a possible bot user).

Playing Sessions

Now, you could let the bot run for days or even weeks on end. But that would be foolish wouldn't it? Not only would you possibly flag your account and cause troubles for yourself, but it could even result in causing problems for the rest of us. Please bot responsibly. Playing 10-12 hour days with 8-12 hour breaks in between is reasonable. Take a day off now and then as well.

There are several ways to set the max session, including by when your stack size reaches a certain level so you can book a win and walk away. See the instructions text file for more detailed information.

Bathroom Breaks

The Hold’em Bot comes with a bathroom break scheduler and it is recommended to use this feature in cash games. The bot will sit out for two or three minutes then sit back in. This can be scheduled as often as you like. However we recommend three minutes every 90 to 120 minutes. Be sure to turn it off in tournaments (this is done by making the interval time higher than your max session time).

Avoiding Being Profiled

Because our bots are programmed to take different actions in the some of the same scenarios based on random elements, and because there are quite a few user option settings which can be changed for No Limit play, they are difficult to profile. They also play well short-handed so it’s hard to get pegged as a bot and be exploited for it. Still, it’s a good idea to play without the bot once in a while just to keep players who are taking notes on you off kilter. (At the lower limits this isn’t something you should even be concerned about.)
Poker Room Upgrades

From time to time a supported poker room will upgrade their software in a manner that temporarily breaks the bot. This is no time to panic! Rest assured that we probably already know about it and are working on the fix. Watch our forum announcements and/or subscribe to our RSS feed for the announcement of when you can download the upgrade.

Our Forum URL: www.bonusbots.com/support

The Rake: Your Worst Enemy

Most poker players completely underestimate their most formidable opponent, the rake. The rake always ends up with the most money over any reasonable time period. It’s like an opponent who is guaranteed to book a big win every single time you sit down at a poker table. And that makes things very tough!

Consider this: A game where the average stack is $150 and the average rake is just $.60 per hand, dealing 65 hands per hour. This is typical of many online games. In 23 hours the rake will have taken every single chip on the table. That’s right, all of it. You can’t imagine how profitable the larger online poker rooms are. And you had better understand that this is a near-impossible proposition to escape from, unless:

A) your opponents are playing terribly, and/or
B) you are getting a significant portion of that rake back through bonuses and/or rakeback.

Full 9 and 10-handed games are one way to help curb the sting of the rake. It’s cost is significantly less at these tables, as more players share in the bill and the blind pressure is less. This means that you can play tighter and be rewarded for it. (That’s why our Hold’em bot plays extremely tight in full ring games.) The drawback is, only good players seem to understand this and so the full 9/10 tables just don’t have a lot of bad players in them any more. That’s a real problem.

Another way to escape the rake is to play tournaments, especially multi-table tournaments (MTT’s). There is so much dead money in these things that you don’t need rakeback or bonuses to profit from them nicely. Dead money is a term that refers to people who have no chance of finishing high, and MTT’s always have enough of them to more than cover your entry fees.

Even SitNGOs (SNG’s) can be a profitable way to avoid the rake at the lower buy-ins. For example, $5 and $10 SNG’s have enough dead money – people just messing around who aren’t really serious – to be quite profitable without needing
any bonuses or rakeback. As you move up to the medium and higher buy-in games the dead money vanishes, however. But in those games all you have to do is play solid and keep your cool in order to have an edge which negates the entry fee, something that bots happen to excel at.

All in all tournaments are an **excellent** way to escape the rake.

Finally, for those with the means and the stomach, high-stakes cash games can be the route out of the rake’s devastating grasp. Once the average pot size is significantly above the size where the max rake per pot is reached, it becomes much less of a factor. In these games the players are all pretty good and so small edges are obtained by those who don’t go on tilt or make stupid mistakes. Again, this is something that our bot is a champion at.

However, high stakes games have other pitfalls, not the least of which is having a tendency to become short-handed where it’s just you and a couple of the best players in the world. Obviously you want to avoid that and so the sit-out option on our bot should be used at these tables if you want to take a crack at them (we’d also recommend sticking to limit). The other problem is that high stakes games can become high-profile, something botters should try to avoid. But our bot actually should do OK at high-stakes limit tables that stay full – just don’t play too long.

**Level of Competition**

This is the final ingredient. Terrible players will pay your share of the rake as well as theirs, and leave you a little something to boot. If there are a couple of them in your game, rest assured that everybody will get paid. They are the life blood of good online poker players, and even the best poker bot needs them in order to be profitable. This is a critical concept.

In fact if there are not bad players frequently coming into your games, you are not going to make a profit - with or without a great pokerbot. Even the poker rooms with the best rakeback programs and bonuses are not giving it all back. There will be a small deficit to make up, and the bot will need poor players making frequent poor decisions in order to grind out an hourly profit. This is why a table full of poker bots is simply not going to work, no matter what the rakeback and/or bonus scheme is.

Without bad players, the best you’ll be able to do is lose less than everybody else. This is very important to understand. Seek out soft games. It’s worth your time. There are tools available to help you do this. Just having Poker Tracker can be a tremendous resource. You can check in on your bot every now and then, scan the tables for players with bad stats, change tables, turn your screen off, and come back in an hour or so to repeat the process. This exercise, if you have the ability to pull it off, will improve your results in cash games **dramatically**.
Bad stats are players with high VPIP and low PFR%. In other words, they play a lot of pots but don’t raise before the flop much. These are the kind of players that will make the bot profitable, and it greatly behooves you to find them and sit at their table. (The other stat you might check for is a low won at showdown percentage, or perhaps just a high dollar loss for the number of hands you have recorded on them.)

**Multi-Tabling**

Both our poker bots can currently play up to six tables at any of our supported poker rooms (except Bodog where they allow a maximum of 4 tables per player). This function works best on large monitors where you can separate the tables farther, but even on small screens where the multiple tables obscure each other it will work as long as the buttons themselves do not overlap. The exception might be if you must *Use OCR* in order to play and also have a small monitor (more on that below).

The bots can also multi-table between game types, although we do not recommend multi-tabling while playing an MTT because the additional tables open can trip up the bot when you experience a table change. Please note that you cannot multi-table across poker rooms, either – all your tables that are open must be at the same room.

The only thing you need to watch when multi-tabling are **staggering** your tables. Separate your tables as much as possible without hanging them off the edge of your monitor.

**Table Positioning Tip:** If you have a big screen you should try and position the tables so that there is minimum overlap between them. On smaller screens you should at least position the tables such that the button areas do not overlap. Position the 2nd table window such that it is a little (about two inches) to the right of and a little (about 2 inches) below the 1st table and so on.

**How to Multi-Table**

A menu item named **New Window** can be found on the **Holdem** menu. Clicking on this causes a new bot window to be opened up. The new window will ask for the additional poker table name, which you should already be sitting at. You need to type that in exactly as it shows in the poker window, as this is case sensitive.

A max of 6 bot windows can be open simultaneously. Each bot window acts independently and can be used to connect to and play at a particular poker room as per the rules above. Profiles need to be loaded independently in each window. They can be hidden and brought up independently. They write in separate log files. The log for the first window is called holdem.log (or om.log for the Omaha/8bot) as usual. The log for the second is called holdem2.log and so on.
Each window is independent, so one can play Limit and another No Limit etc. without getting confused.

Most people can hide all Bot windows on their machine when multi-tabling. This is a sure way to speed up clearing bonuses and/or earning rakeback.

**Custom Profile Creation**

Our poker bots have an option menu where you can choose certain settings for the type of game you plan on playing in (be it a tournament, short-handed cash game, etc.). So that you don’t have to do this every time you change game types, you can save your settings as a profile. This allows you to quickly load different profiles and you can even load different profiles for different tables while multi-tabling. Details on how to do this are given a bit further in this manual, as well as in the instructions text file that came with our software.

The Hold’em bot now has over 30 individual settings on the option menu. In addition to these option menu settings, our poker bots are now completely **user-programmable** as well. We created a simple language that most poker players can easily learn so you can completely program the bot's entire playing instructions to your liking, if you so desire. The language is known as **PPL** which stands for Poker Programming Language.

Please note that this isn’t really necessary and many of our customers have reported great results from profiles created using the option menu. But if you are hardcore you might enjoy doing a bit of custom coding to your bot.

Also note that you don’t have to code an entire profile either. You can create small snippets of PPL code just to handle one or two situations in a certain way and use the option menu for the rest of the profile.

User-created custom code simply needs to be inserted on the saved profile (which is a text file) underneath where you see the option menu choices displayed. Please read the **PPL User Guide** that also came with your software download to learn how to create custom code.

**Stack Size Recognition**

Our poker bots read their stack size from the poker table window when it is time to act. They take this information into making certain decisions based on options that you have selected. The stack size is read and recorded in dollar amounts. However some of the settings on the option menu that include stack size ask you to set it by number of big blinds. The bot does the conversion automatically. You probably need to do a little calculating to figure out how to set the stack size by number of big blinds for these settings.
Please note that these settings have a very high initial value, which means they are always on for any stack size if you turn the above option on. To make the above option only happen when your stack gets short you need to enter a number that represents a short stack, for example 15 or 20 (15 or 20 big blinds is a reasonably short stack in many situations).

Total Investment

The bot keeps a running tab of its total investment in any given hand. At least one option menu setting allows you to set it by Total Investment. The purpose is to keep from folding in situations when you are pot-committed.

Hold’em Bot Strategy

Get ready for some real fun. Most of our supported poker rooms offer substantial deposit bonuses which can be worked off using the bot. Some of them also offer rakeback deals through various affiliates. See the beginning of this use manual for the list of currently-supported sites, and/or log in to our support forum to get the scoop on the latest rakeback deals.

Games the Bot will Play

Our Hold’em poker bot will play the following types of games:

- Limit cash games 6-max
- Limit cash games 9-max or 10-max
- Limit SNG’s
- Limit MTT’s
- NL Cap cash games 6-max
- NL Cap cash games 9-max
- NL cash games 6-max
- NL cash games 9-max or 10-max
- NL SNG’s
✅ NL MTT's

✅ PL cash games 6-max

✅ PL cash games 9-max or 10-max

✅ PL SNG’s

✅ PL MTT’s

How’s that selection for you? Basically the bot will play any form of Hold’em being spread in any structure. In order to accomplish this we had to give the bot a different set of instructions for different game types, and we also decided to include some user controlled options for certain types of games. Let me try and break that down for you.

**NL, PL, and NL Cap Games** – the bot plays all these types of games the same way, whether cash or tournament. The major differences between this type of game and Limit Hold’em lies in calling raises, both preflop and post-flop, and also in calling non-raised pots preflop. In this type of game the bot folds to raises that it will call in Limit. It will also call the blind with small pocket pairs in this type of game (trying to flop a set) whereas in limit it will almost never play those hands.

In NL and PL games there are some options that need to be set. Two of these also affect Limit game play. I will give you some general guides in the strategy section below, but for now let’s go over what they are. You can find these on the Options menu of the bot program window.

**Option 1: Set the Preflop Raise Size** – You can set the preflop raise amount to always be the minimum, always be pot-sized (about 3.5 x the big blind), or sometimes bet the pot and sometimes bet the minimum based on either a random element or hand strength. In low-stakes cash games I prefer to always raise the minimum, in slightly higher stakes cash games I like to use one of the random elements, in low stakes tournaments I prefer to always use the pot-size raise, and in higher stakes tournaments I like to set it by hand strength.

**Option 2: Set the Post-flop Bet Size** – You can set the post-flop bet/raise size by a % of the existing pot-size for the Flop, Turn, and River. For example you can have the bot bet 75% of the pot on the Flop, 60% of the pot on the Turn, and 50% of the pot on the River.
Option 3: Fold to Preflop Raises for AQ, AJs, KQ – this is just what it sounds like. The default position is off, meaning that if you do not check this option the bot will call preflop raises when holding these three hands. In limit the bot always calls one preflop raise with these hands but you can make it fold these hands for a preflop raise in No Limit and Pot limit. Generally speaking I would recommend keeping the default setting in lower stakes games and checking it on for higher stakes games.

Option 4: Fold Post-Flop Below Top Pair to Any Bet or Raise – this is a post-flop setting that will give the bot an overriding instruction to always fold any hand below top-pair in strength to any bet or raise. You can leave this off and the bot will play by the default instructions and sometimes call large bets with certain drawing hands like a medium pair with a flush draw. Or you can check this option and always be safe from donking off your stack to a large all-in bet when holding anything under top pair.

Option 5: Fold to Postflop Raises with Unpaired Boards for – this is a post-flop setting that will give the bot an overriding instruction never to call a raise with a hand below the strength of your choosing. Note that this is only for non-paired boards with no possible made flush and no possible made straight. The default setting is top-pair best kicker, and that is the loosest possible setting (in limit the bot will often call raises with any top pair or combination pair/draw hands). My recommendation is to tighten this setting as you play higher stakes. I’d lean towards checking this option in tournaments and higher stakes cash games.

Option 6: Fold to Postflop Raises with Paired Boards for – when the board is paired what is the minimum strength hand you want to call a raise with? The default setting is trips with best possible kicker. You can loosen this or tighten this at your discretion. Again, in limit the bot will play a bit looser and I would tighten this setting in certain higher-stakes situations.

Option 7: Never Bet Turn or River with Hand Below – (note this setting also affects Limit games) here you can turn off the automatic continuation bluffs on the turn, which is a good idea in higher stakes cash games and late stages of tournaments, especially when you are close to the money. If you leave the default setting the bot will make pot-sized bluffs on the turn when against one opponent and the bot bet the flop and was only called and it’s first card is a certain color. Setting this option to at least second best pair is probably a good idea for tournaments and all but the smallest stakes NL games.

Option 8: Never Bet Flop With Hand Below Middle Pair When – (note this setting also affects Limit games) you can turn off all flop continuation bets with this setting. However it is not recommended that you use this setting unless you really know what you are doing.

Note that one of the options is to turn it off when your stacks size falls below a certain level, and that is probably the best use for it (in a tournament situation).
When your stack is getting small you don’t want to waste chips on pot-sized bets stabbing at the flop and are really just looking for hands to push with pre-flop.

This setting is for experts only. You are usually making a big mistake by not automatically betting the flop when you were the last preflop raiser.

**Option 9: Never Call Paired Boards with Hand Below** – by default the bot will call one bet on certain paired boards with good two-pair hands, especially when the board pair is small and the two pair hand is of the highest other board card or better. With this setting you can tighten that up, which might be a good idea in higher-stakes cash games.

**Option 10: Never Call Flush Possible Boards with Hand Below** – by default the bot will call one bet with certain hands when a flush is possible, especially when two cards are needed for a flush and the bot has a decent hand against only one or two opponents. With this setting you can tighten that up, which might be a good idea in higher-stakes cash games.

**Option 11: Fold to Preflop Raise with 55 or 66 when** – set how the bot will handle these two hands preflop when there is a raise. If you leave it in the default position it will sometimes get all-in with them preflop, which is a good idea when you are short-stacked in tournaments – but not any other time really.

**Option 12: Fold to Preflop Raise with 77 or 88 when** – these hands are somewhat better than the above two, and this option will allow you to set how they handle preflop raises. In cash games it’s probably a good idea to fold them for a raise. If you leave this setting in the default position the bot will always reraise and try to get all-in with them preflop (which is a good setting for tournaments).

**Option 13: Fold to Preflop Raises with 99 or 10-10 when** – these hands are significantly better than the above two, and this option will allow you to set how they handle preflop raises. In cash games it’s probably a good idea to fold them for two raises. If you leave this setting in the default position the bot will always reraise and try to get all-in with them preflop (which is a good setting for tournaments).

**Option 14: Fold to Preflop Raises with JJ or QQ when** – these hands are significantly better than the above two, and this option will allow you to set how they handle preflop raises. In higher-stakes cash games it’s probably a good idea to fold them for two raises. If you leave this setting in the default position the bot will play them very intelligently, usually trying to get all in but backing off for a lot of action when out of position.

**Option 15: Fold to Preflop Raises with AK when** – one of the strongest preflop holdings in a tournament, but somewhat vulnerable in a cash game. In higher-stakes cash games it’s probably a good idea to fold for two raises. If you leave this setting in the default position the bot will play AK very intelligently, usually trying to get all in but backing off for a lot of action when out of position.
**Option 16: Fold to Preflop Raises with AQs when** – this hand has roughly the same value as AK (offsuit), but presents more challenges in playing correctly. In general you should be less willing to get all-in with it in tournaments preflop, and be wary of too much preflop action in cash games. Some players like to tighten up with this hand. We recommend folding for two raises with it in cash games and the early stages of tournaments.

**Option 17: Fold to Preflop Raises with AKs** – don’t ask me why we are even giving you this option. We just threw it in there. Some experts might want to fold for two raises in certain game environments I suppose. Recommend leaving this in the default position.

**Option 18: Fold to Preflop Raises with KQs** – probably a good idea to fold for two raises in cash games but play by default when short-stacked in tournaments.

**Option 19: Fold or Go All-In when Opponents (After Folds) Less than** – This feature will have the bot simply click the max button and go all-in anytime it has a playable hand. That includes a calling hand or a raising hand, the only exception being when it is in the big blind with a folding hand and gets a free look at the flop. In that case the bot will then go All-In after the flop in any situation where it would call or raise. You can set this for always, or by the number of remaining opponents. If you choose a number of remaining opponents then you would still be playing normal against a higher number of opponents. Believe it or not, using this setting in the *Always* position can be an effective way to play tournaments.

You can also set this option to apply only after a specified number of hands in your session has expired, which can be very effective in multi-table tournaments. Figure on about 50-60 hands per hour being dealt when deciding when to have it kick in.

Finally, you can also set this option to trigger only when your stack size is below a certain level.

**Option 20: Fold or Go All-In when Opponents at Table Less than** – This is the exact same feature as option 16 above, except that it is triggered by the starting number of opponents instead of the remaining number. In other words, the original number of opponents sitting at the table. If option 16 above is chosen, the bot may very well push all-in on the first hand of a tournament.

By contrast, if you want the bot to only start pushing all-in when down to the last few players of a SitnGo (or multi-table tournament) then this is the option you want. Frankly, we see that as a good idea for all types of NL Tourneys. (The bot will still fold and check it’s non-playable hands).

You can also set this option to trigger only when your stack size is below a certain level.
Please note that both Fold or Go All In options should not be turned on at the same time. Choose one or the other, or use the Aggressive Tournament Setting instead.

**Option 21: Always Call When Opponent's Raise is Less than** – because you don’t want to fold for very small raises after you make a large bet in NL or PL games, the bot won’t let you. It will always call a raise from an opponent that is less than 40%, 30%, or 20% of the amount of the bot’s last bet (or raise). Which percentage is up to you. For most tournaments you probably want to set this to 40%.

On the river, there is a minimum hand strength requirement that you have at least best kicker or better before calling the small raise. For all other betting rounds however the bot will call small raises with any hand that it had bet with.

This feature also extends to the next betting round. The bot remembers when it was the last bettor or raiser on the previous betting round and if somebody bets their last few chips out it will treat that as a raise on the previous betting round and apply these settings.

Included on the window for this setting is the most important incorporation of **Stack Size Recognition**, being able to compare it to **Total Investment**. The option reads:

**Always Call when Stack Size is Below**

…and lets you set the percentage. It’s important to understand what the percentage setting means. You are setting your stack size as a percent of total investment in the hand. The initial value is set very low at 30%. That means if you have $1,000 in chips invested in a hand but only have $400 left in your stack the bot will still fold to many raises protecting your last $400 because that is 40% of the amount you have invested in the hand. However if you had this set to 50% then the bot would always call any bet or raise if you only had $400 left in this situation.

So what this setting does is override all folding action to calling once you have put a certain amount of your stack in a pot. Some people think they are pot-committed whenever they get half of their stack or more into any given hand, especially in SNG’s. In that case you would want this setting at 100%.

*Remember the bot makes a comparison of your current stack size to the amount you have invested in the hand. So if you got 50% of your stack in on a given hand that would mean the total investment now equals 100% of your current stack size.*
Option 22: Super Tight Play – (note this setting also affects Limit games) this setting will have the bot fold all hands preflop except: AA, KK, QQ, JJ, 10-10, 9-9, AKs, AK, AQS, AQ, AJs, and KQs which it will play normally. Some people like to have the bot play the first half of a tournament for them with this setting before taking over themselves.

Option 23: Semi-Super Tight Play – (note this setting also affects Limit games) the same thing as Super Tight Play above but includes all pocket pairs. Note that the bot will play them by default programming with this setting, which only includes calling minimum raises when holding the smaller pocket pairs. You can use the Set Mining option below in conjunction with Super Tight to call larger preflop raises with smaller pocket pairs if you so desire.

Option 24: Minimum Bet Override – this setting stops opponents from making a minimum bet into a large pot to get the bot to fold without incurring any risk on their part. It is invoked anytime that an opponent makes a post-flop minimum bet (exactly 1 big blind in size) in a No Limit or Pot Limit game environment where the pot is at least 5 big blinds in size and your hand value is best high-card or better. You can choose how you want to handle this: Call all post-flop minimum bets, raise minimum sometimes and fold sometimes, or raise minimum sometimes and call sometimes.

We recommend always calling in tournaments, and raising minimum sometimes and calling the rest of the time in cash games. Please note that this setting is in the default position when you downloaded your bot which will not recognize minimum bet sizes, so you do need to change this one to your preference.

Option 25: No Limp – (note this setting also affects Limit games) if you hate limping this setting is for you. We added it after some of our customers shared their Poker Tracker databases with us, making a strong argument against ever limping at all in cash games. While we aren’t quite sold on that concept, we do think it’s a good option for most 6-max cash tables. (There aren’t very many hands the bot will limp with anyway, especially while playing short-handed.)

The setting affects every position except the Big Blind, and when activated will never just call the blind preflop. You can choose how you want to handle the few hands that it would normally limp in with. There is an interesting setting that will raise if less than two callers otherwise fold. Note that this setting only affects hands where bot is instructed to call – it will not start playing any hand that way!

Also, the setting is only invoked the first time around the table. After you have raised the bot will then call reraises if it is supposed to (with hands like AK and QQ).

Option 26: Aggressive Tournament Setting – this is highly recommended for tournaments of all types and sizes. Playing cash games requires a different approach than playing tournaments (with the possible exception of really small stakes cash games). When this option is left in the default position the bot will
fold many decent hands for a large bet size. That’s the best way to play most cash games above the micro limits. However in tournaments you are going to want to shove all-in with many of those same hands that you want to fold in a cash game. That’s what this setting does - it uses the Bet Max button in NL games when it holds a good hand. There are two sections to this setting and one selection must be made in each of them.

**Preflop section.** Here you can choose from among a half-dozen hand lists that the bot will simply shove all-in with preflop. The first one on the list consists of only the very top starting hands and also requires at least one preflop raise before it will shove. The rest of them get progressively looser and do not require a preflop raise. In general, the earlier in the tournament and/or the bigger stack you have the closer to the top you want this preflop section set - and vice-versa.

**Postflop section.** This side only has two choices (other than off). The setting refers to the post-flop conditions for which the bot will bet or raise all-in. These are not defined for the user. We programmed the bot to push with any decent post-flop hand when this setting is invoked. This includes top pair or better on non-scary boards and reasonably strong hands on scarier boards. Your only choice when you turn this on is whether you only want to shove all-in when the conditions are met if there was a preflop raise, or whether you want to shove all-in regardless of whether or not there was a preflop raise. In general, the earlier in the tournament and/or the bigger stack you have the more you would want to require a preflop raise before shoving with any decent hand post-flop.

**Stack size recognition.** For both preflop and post-flop sections there is an option to only invoke the setting when your chip stack falls below a certain level. When you turn this on (by reducing the number of big blinds to a level that reflects a short stack) the bot will only play by the Aggressive Tournament Settings you have chosen when the stack size requirement is met. For example you might set the stack size requirements at 20, as anytime you have under 20 big blinds that is considered a short stack in a tournament. (You might want to set both sides at the bottom level and set the stack size to 20 so that anytime you get short-stacked you just start pushing all-in with reasonable hands.)

**Option 27: Mining for Sets** – the default instructions for calling raises preflop is to fold for raises 4 big blinds or higher with 22 through 66 and to fold for raises of 6 big blinds or higher with 77 through 99. This setting allows you to override the default instructions and always have the bot call with 22 through 99 up to a raise amount that you choose. In deeper stack games it might be a good idea to set the number around 7 or 8.

**Option 28: Post-Flop In Blinds Override** – (note this setting also affects Limit games) in Texas Hold’em you often get a free look at the flop from the big blind position. Sometimes that means you flop top pair with a weak hand such as 10-3. By using this setting you can tell the bot you basically don’t want to get involved in these pots without having a good hand, that is at least top pair with a
decent kicker. There are two choices: Second best kicker or better, or third best kicker or better.

When you check this setting on it will simply give up on all other hands from either blind position as long as there was no preflop raise. These are situations when you have nothing invested. If there was a preflop raise the setting won’t be invoked and the bot will play as normal, since you do have something invested in that case.

The drawback to this option is that the bot will also abandon continuation bets on the flop when it was the last preflop raiser as well. However this might be a good way to randomize backing off on your aggressiveness a little, since you are out of position on these hands.

**Option 29: Preflop Reraise Override** – (note this setting also affects Limit games) if you only want to reraise (that is 3-bet or 4-bet) with aces or kings, check this setting. It is one that simply turns on or off with a check mark. When on, the bot will only reraise preflop with AA or KK and just call with the other premium hands which it would normally reraise with.

**Option 30: Auto Rebuy at UB and Bodog** – when you go broke in a cash game at these two rooms a window pops up asking if you want to buy more chips. By checking this option on the bot will click the Rebuy button and then click OK on the box that pops up. Note that this will only rebuy for the amount suggested by the poker room software which may not be the maximum.

**Saving Your Options As a Profile** – For convenience, you can now save your option settings as a profile, which becomes a text file that is stored in the same folder your bot program is kept. That way you can quickly change option settings when you change game environments. Don’t forget to have the bathroom break setting on 900 minutes for tournament profiles and around 80-120 minutes for cash games profiles!

To save a profile, click on the first item on the main menu Holdem: Write Profile. A window will appear with the default name "holdem_profile.txt." You will want to rename this to something easy to remember when loading your profile. (Please note that the .txt extension must remain.) For example, cash.txt or sng.txt.

To load a saved profile, go to Holdem: Read Profile... then just type in the name of the saved profile that you want to load. You will get a confirmation message in the bot window that your profile loaded, along with all the options set for that profile.

**Auto Switching Profiles** – You can also set the bot to change the profile it is using based on a preset condition. The conditions you can use for loading a different profile are:

- Shorthanded table by number of players sitting at it
- Number of hands played in the current session
• Number of minutes expired in the current session
• Stack size has fallen below a certain level

This is a very useful feature, as you probably want to use a different profile in a short-handed game than at a full table, or switch to a push-or-fold type profile when your stack is short. Also, some players like to play the first two hours of a tournament very conservatively then become very aggressive (or vice versa).

To set up the the profile auto-switch, on the bot’s main menu go to:

**Holdem > Auto Read Profile**

Then enter the saved profile file name (or path) and set the criteria for when you want it loaded.

**Rakeback**

It’s important that you open up your accounts through our recommended rakeback provider below. If you already have accounts at all our poker rooms and thus cannot get the rakeback, I would recommend playing tournaments only. This bot does extremely well in the tourneys, making the money often. Every once in a while the poker room will throw you a bone in the way of a surprise deposit bonus. These surprise bonuses should be cleared in the cash games.

**Strategy**

There are a lot of ways to go at these poker rooms. I’m sure you can find something that works for you. However we strongly advise focusing on **No Limit and Pot Limit** rather than Limit games.

The edge that solid players have over poor players in No Limit is gigantic. In limit the fish live longer because they aren’t usually taking that much the worst of it due to pot odds. But in No Limit they often get their whole stack in there as a 3-1 underdog or worse. **This more than makes up for the lack of bonuses.**

I am going to divide the specific strategies into two parts: **Semi-monitored** and **Non-monitored**. The semi-monitored section assumes that you can check in on the bot frequently, maybe once or twice an hour. This option is good for people who can put an extra PC on their desk at work (perhaps via a KVM switch so they can use the same monitor, keyboard, and mouse).

Going the semi-monitored route will improve your cash game results, no two ways about it. You will need extra software to get the most from it. The best bet is purchasing **Poker Tracker 3**, which use can use to data-mine many tables when
you are not playing or using the bot. Then all you need to do is start keeping a list of currently active players who have:

• High $VPIP Numbers (above 45 is best)
• Low PFR% Numbers (below 7 is best)

These players will be putting lots of money into post but hardly ever raising. If you always make sure at least one of them is at your table you should do very well in your online poker career, with or without a bot.

If going to these lengths is not something you are able or want to do, don’t worry. The bot will do just fine playing the PL and NL cash games and all manner of tournaments in a completely un-monitored fashion. However, I would recommend avoiding the limit and cap games if you are not using extra software to do frequent table-hopping.

Semi-monitored Strategies

Here are my recommended games and corresponding strategies for using the semi-monitored botting approach.

NL Cap Cash 6-Max

While the 9-max tables are cheaper in rake, the 6-max tables are richer in maniacs - one of the easiest kind of fish to beat. NL Cap 6-max seems to be a really good game for letting the maniacs blow off their chips. In my personal testing it was an excellent fit with Poker Usher, and I saw some impressive upswings in the lowest limit game (.05/.10 blinds $10 max buy in).

Strategy – Buy in for the max. If playing at UB you will have to check back frequently to buy-in manually when you lose your stack), check in once or twice per hour to move to the most profitable looking table. Take the time to run through all the tables a couple times per day and buddy-list players with high losses, $VPIP over 45, and PFR% under 7. Use the games that your buddies are in as targets regardless of where the tables rank on Poker usher, and especially target games with 2 or more buddies.

Preflop Raise Size - recommend random pot-sized  
Folding to Preflop Raises – recommend checking to on  
Folding to Postflop Below Top Pair – recommend leaving off  
Calling Raises Post Flop – recommend any two pair  
Calling Raises Paired Boards – recommend trips best kicker  
Never Bet Turn or River with Hand Below – recommend top pair  
Never Bet Flop with Hand Below Middle Pair– recommend play by default  
Never Call Paired Boards with Hand Below – recommend play by default

Never Call Flush Boards with Hand Below – recommend play by default
55 and 66 – recommend fold for one raise
77 and 88 – recommend fold for one raise
99 and 10-10 – recommend fold for two raises
JJ and QQ – recommend play by default
AK and AQS – recommend play by default
AKs – recommend play by default
KQs – recommend fold for two raises

Limit Cash 9 or 10-Max

Limit actually works very well with table-targeting, and there are enough full 9/10 handed tables going to make this work. In these games you enjoy a much lower rake paid per hour along with decreased blind pressure. Our bot plays extremely tight at these tables and punishes opponents who get involved with our solid holdings.

Strategy – Buy in for about three times the suggested amount. Check in one or two times per hour to move the bot to the most profitable looking table. Just go with the tables at the top of the Poker Usher list, but do check them to make sure there are significant stats on the opponents. Anybody with a 45+ $VPIP and a PFR% under 7 after 80 or so hands is a reliable target.

Singe-table SNG’s

You don’t need any extra software for this approach. You just need to keep checking in several times per hour to get the bot started in another SNG when the last one is over. Glamorous? Perhaps not. Profitable? You bet! This actually might be the single best use for the bot, as it’s great at these things.

For NL and PL SitnGo’s:

Preflop Raise Size - recommend pot-sized
Folding to Preflop Raises – recommend leaving off
Folding to Postflop Below Top Pair – recommend checking on
Calling Raises Post Flop – recommend top pair
Calling Raises Paired Boards – recommend trips best kicker
Never Bet Turn or River with Hand Below – recommend default settings
Never Bet Flop with Hand Below Middle Pair – recommend play by default
Never Call Paired Boards with Hand Below – recommend trips
Never Call Flush Boards with Hand Below – recommend trips
55 and 66 – recommend fold for one raise
77 and 88 – recommend fold for two raises
99 and 10-10 – recommend play by default
JJ and QQ – recommend play by default
AK and AQS – recommend play by default
AKs – recommend play by default
KQs – recommend play by default

**Aggressive Tournament Settings** – both sides on, preflop in an upper middle position and post-flop in the second position

**Strategy** – Play within your bankroll but don’t be afraid of the higher limits if you can afford them. I would try to maintain an account size of at least 20 buy-ins to handle the swings. Experiment with the option settings at different buy-in levels.

**Tournament Starter**

You don’t need any extra software for this approach. As an MTT player you are simply going to let the bot do your grunt work to get you to past the middle stages of a tournament and then take over.

For NL and PL tournaments:

- **Preflop Raise Size** - recommend pot-sized by hand strength
- **Folding to Preflop Raises** – recommend leaving off
- **Folding to Postflop Below Top Pair** – recommend checking to on
- **Calling Raises Post Flop** – recommend top pair best kicker
- **Calling Raises Paired Boards** – recommend trips best kicker
- **Never Bet Turn or River with Hand Below** – recommend 2nd top pair+ overcard
- **Never Bet Flop with Hand Below Middle Pair** – recommend play by default
- **Never Call Paired Boards with Hand Below** – recommend trips
- **Never Call Flush Boards with Hand Below** – recommend trips
- 55 and 66 – recommend fold for one raise
- 77 and 88 – recommend fold for two raises
- 99 and 10-10 – recommend play by default
- JJ and QQ – recommend play by default
- AK and AQS – recommend play by default
- AKs – recommend play by default
- KQs – recommend fold for two raises

**Aggressive Tournament Settings** – both sides on, preflop in an upper position and post-flop in the first position

**Strategy** – Play any MTT you have a notion to play, be it NL, PL, or Limit. Put the bot in and check back in 1-3 hours, depending on how large the field was. Stay away from the turbo multi-table SNG’s, as what you are trying to do is capitalize on your tournament skills and those are more of a crap shoot. When the bot gets to a point and chip position that you want to take over the reigns at, step in and finish the job. If the bot busted out enter another one and go back to the hot tub. I like to take over at the bubbles (near the money or near the final table). Also, when the bot is a huge chip leader early or middle I will sit it out for a while.
NL Cash Games

This is my last choice for semi-monitored strategies and my first choice for non-monitored strategies. The reason is this: I don't think the edge you get from wise table selection means as much in no limit cash games. Especially at the lower limits where the games are all pretty juicy anyway, and especially the 6-max tables. I might be wrong. Truth be told I haven’t tested it much so my opinion might change. But the player base is so large at these that you might have a difficult time gathering usable stats.

Preflop Raise Size - recommend AK or better
Folding to Preflop Raises – recommend checking to on
Folding to Postflop Below Top Pair – recommend checking to on
Calling Raises Post Flop – recommend any overpair
Calling Raises Paired Boards – recommend trips best kicker
Never Bet Turn or River with Hand Below – recommend top pair
Never Bet Flop with Hand Below Middle Pair – recommend play by default
Never Call Paired Boards with Hand Below – recommend trips
Never Call Flush Boards with Hand Below – recommend trips
55 and 66 – recommend fold for one raise
77 and 88 – recommend fold for one raise
99 and 10-10 – recommend fold for two raises
JJ and QQ – recommend fold for two raises
AK and AQS – recommend play by default
AKs – recommend play by default
KQs – recommend fold for two raises

Strategy – Buy in for the max, set your auto rebuy option for the max. If playing at UB you will have to check back frequently to buy-in manually when you lose your stack), check in once or twice per hour to move to the most profitable looking table. Take the time to run through all the tables a couple times per day and buddy-list players with high losses, VPIP over 45, and PFR% under 7. Use the games that your buddies are in as targets regardless of where the tables rank on Poker usher, and especially target games with 2 or more buddies.

Non-monitored Strategies

Stick the bot in a game, turn it on, check back in 10-12 hours. This is real botting, and the reason many of you are interested in this product no doubt. I have a very different hierarchy of strategy preferences for this approach. Here they are.
NL Cash 6-Max Maximum Rebuy

The preferred method to play NL cash games on complete auto-pilot. The action players gravitate toward the 6-max tables, so even with the higher rake they are more profitable when the betting gets bigger. This is because your opponents are much more likely to donk off their stack than they are at the 9-max tables.

- **Preflop Raise Size** - recommend AK or better
- **Folding to Preflop Raises** – recommend checking to on
- **Folding to Postflop Below Top Pair** – recommend checking to on
- **Calling Raises Post Flop** – recommend best possible overpair
- **Calling Raises Paired Boards** – recommend trips best kicker
- **Never Bet Turn or River with Hand Below** – recommend top pair
- **Never Bet Flop with Hand Below Middle Pair** – recommend play by default
- **Never Call Paired Boards with Hand Below** – recommend trips
- **Never Call Flush Boards with Hand Below** – recommend trips
- **55 and 66** – recommend fold for one raise
- **77 and 88** – recommend fold for one raise
- **99 and 10-10** – recommend fold for two raises
- **JJ and QQ** – recommend fold for two raises
- **AK and AQS** – recommend play by default
- **AKs** – recommend play by default
- **KQs** – recommend fold for two raises

**Strategy** – Buy in for the max and set your auto rebuy option for the max. If playing at UB you will have to check back frequently to buy-in manually when you lose your stack). The maximum allowed buy-in for your game should be no more than 5% of your account size, and even that might be pushing it.

NL Cash 6-Max Minimum Rebuy

The problem with an in-between rebuy strategy is extremely high variance. For example, in the $10 max games if you rebuy for $4 you will have many losing days and one huge winning day every now and then that makes it all back. This is because the bot will be constantly building a stack to $8, $12, $16, even $20 and then losing it all in one hand to another big stack in the game and starting over.

This actually wouldn’t be a bad semi-monitored strategy, if you kept checking in and leaving the game every time you had accumulated a decent stack - say 3 times your rebuy amount. Then just change tables and start over. That way you keep bagging profits and lowering your risk.

A maximum buy-in amount approach doesn’t suffer from this problem because it has so many opponents covered. It is starting with a much higher stack and therefore isn’t trying to **win 4 or 5 coin-flips in a row** to stay in business. If you
let the bot run with a middle buy-in amount you will probably get frustrated with your short-term results.

A minimum buy-in approach, on the other hand, is much better! This will reduce your short-term variance while still giving yourself a shot at huge profit days relative to your risk. So to recap, go with a minimum or maximum buy-in strategy, but not with any amount in between.

**Preflop Raise Size** - recommend 99 or better
**Folding to Preflop Raises** – recommend leaving off
**Folding to Postflop Below Top Pair** – recommend leaving off
**Calling Raises Post Flop** – recommend top pair
**Calling Raises Paired Boards** – recommend trips
**Never Bet Turn or River with Hand Below** – recommend top pair
**Never Bet Flop with Hand Below Middle Pair** – recommend play by default
**Never Call Paired Boards with Hand Below** – recommend trips
**Never Call Flush Boards with Hand Below** – recommend trips
55 and 66 – recommend fold for two raises
77 and 88 – recommend play by default
99 and 10-10 – recommend play by default
JJ and QQ – recommend play by default
AK and AQS – recommend play by default
AKs – recommend play by default
KQS – recommend play by default

**Strategy** – Buy in for the minimum and set your rebuy option for the minimum as well. The advantage to this approach is that you can play much higher for your account size, taking shots in larger games with relatively little risk. Definitely give this strategy a try sometime. Experiment with the option settings at the different stakes, always leaning towards playing tighter the higher you go.

**Large Field MTT’s**

In my opinion, this is where the real money is in online poker. You don’t need a rakeback deal and you don’t need a bonus. I have neither going for me, and I let this bot steadily increase my account balance month after month. It rocks.

For example, as I was writing this manual tonight I had the bot play in a 90-player knockout turbo SNG with a $2 buy-in. The bot finished 4th and it’s total return with the knockout bounties was $89. (Please note that this is not the recommended game for this strategy, just giving a real-life example.)

As already discussed, large-field MTT’s have a significant number of players that **cannot** finish in the money. They provide the dead money that finances the pros. That’s why there are websites offering staking deals to online tournament players who are any good at all. This bot can not only finish in the money, but it can take first to win the tournament.
Using our Hold'em bot to play MTT’s, you can win satellites which you can then parlay into big-money scores. You can win awesome vacations for your family. You can end up on ESPN playing at a crazy final table somewhere. It’s all possible from MTT’s, and the bot you downloaded with this manual can get you there all by itself. Seriously. The biggest obstacle for most people realizing this dream is time. With our bot that problem is solved. Sooner or later you will make that big score using it. It’s just a question of when.

For NL and PL tournaments:

**Preflop Raise Size** - recommend pot-sized by hand strength 99 or better  
**Folding to Preflop Raises** – recommend checking to on  
**Folding to Postflop Below Top Pair** – recommend checking to on  
**Calling Raises Post Flop** – recommend top pair best kicker  
**Calling Raises Paired Boards** – recommend trips  
**Never Bet Turn or River with Hand Below** – recommend 2nd top pair+ overcard  
**Never Bet Flop with Hand Below Middle Pair**– recommend play by default  
**Never Call Paired Boards with Hand Below** – recommend trips  
**Never Call Flush Boards with Hand Below** – recommend trips  
55 and 66 – recommend fold for one raise  
77 and 88 – recommend fold for two raises  
99 and 10-10 – recommend play by default  
JJ and QQ – recommend play by default  
AK and AQs – recommend play by default  
AKs – recommend play by default  
KQs – recommend fold for two raises  
**Aggressive Tournament Settings** – both sides on, start high and adjust lower as the tournament progresses.

**Strategy** – get the daily and weekly schedule of the big tournaments and work up a plan of playing satellites for them. Learn when certain large-field daily tourneys start that have a good reward for the buy-in. Develop a routine for the ones you like. Try to stay away from multi-table SNG’s and go for the big payouts instead. A large-field, scheduled tournament will last for 4-6 hours if you get deep into the money, so you don’t need to check in all that often. Just know the schedule of the ones you want to play and check in at the appropriate time to join them.

**NL Cash 9 or 10-Max Maximum Rebuy**

This is a good way to go if you don’t have the stomach for a lot of variance. You will be up against a tighter, more solid field of opponents than at the 6-max tables, but our bot plays even tighter. This means that it doesn’t contribute much in rake so it actually gets rake credits from the looser players. After the flop it plays solid poker. All in all, the looser players will be paying your rake and your profits will come from the bonus or rakeback, albeit at a slower (but reliable) pace.
Preflop Raise Size - recommend AK or better
Folding to Preflop Raises – recommend checking to on
Folding to Postflop Below Top Pair – recommend checking to on
Calling Raises Post Flop – recommend best possible overpair (AA)
Calling Raises Paired Boards – recommend trips
Never Bet Turn or River with Hand Below – recommend top pair
Never Bet Flop with Hand Below Middle Pair – recommend play by default
Never Call Paired Boards with Hand Below – recommend trips
Never Call Flush Boards with Hand Below – recommend trips
55 and 66 – recommend fold for one raise
77 and 88 – recommend fold for one raise
99 and 10-10 – recommend fold for two raises
JJ and QQ – recommend fold for two raises
AK and AQS – recommend fold for two raises
AKs – recommend play by default
KQs – recommend fold for two raises

Strategy – Buy in for the max and set your auto rebuy option for the max. If playing at UB you will have to check back frequently to buy-in manually when you lose your stack. The maximum allowed buy-in for your game should be no more than 5% of your account size, and even that might be pushing it.

Jackpot Targeting

Some poker rooms feature a bad beat jackpot. When a jackpot is hit every person playing that same type of table and limit as the table that hits the jackpot gets a share. In fact a full 25% is distributed this way. So if the jackpot is hit in the .25/.50 NL game ($50 Max Buy-in and the most popular jackpot game by far), everybody playing .25/50 NL Hold’em splits 25% of the jackpot. These jackpots get huge sometimes, and because the bot allows you to play for extended periods you have a pretty good shot at getting some of this money.

Strategy – Wait until the jackpot gets high, like over $200,000 or so. Then play at the most populated jackpot game your bankroll can tolerate, using one of the strategies already listed above for cash games. Make sure you have a bonus to clear or have rakeback going for you as well. If not, find out what the current bonus offer is and make a deposit to get it.
Hold’em Bot Closing Thoughts

There are many more possible botting strategies for these two poker rooms than what I have just written about. These are just a few that I have tried and like. I haven’t even gotten around to the PL games yet. Who knows, maybe playing those with certain options settings will prove to be the most profitable of all.

I don’t like the idea of using the minimum rebuy approach in a 9-max NL game. Remember the bot does need to win a little from the weaker players to stay above water, and it just seems like there won’t be enough opportunities to do that in this type of slower-paced game structure when starting off with a tiny stack.

I believe that there won’t be enough bad play to make up for only a 27% rakeback with no simultaneous bonus if you are not actively table-hopping to take advantage of the worst players.

It’s a good idea to adjust the options settings for the NL/PL games mid-stream sometimes. Good poker players will often change speeds, and these option settings will allow you to do just that. I especially like to do this in tournaments. For example, in the beginning of a low stakes MTT I will often call preflop raises with AQ, AJs, and KQ – but then turn that off when I get to the middle stages.

**Shanky Technologies Team**

[www.BonusBots.com](http://www.BonusBots.com)
Appendix

Error Codes and How to Fix Them

Please note the bot is unlikely these days to ever display any of these error codes on most modern Windows 7/8/10 systems, especially if you have followed the Quick Start setup instructions properly.

Error Code No 1: Version is not compatible

This error is given after Bodog upgrades their software. Such upgrades temporarily break the bot. We normally post a new updated version of the bot which fixes this problem within a few days of the upgrade. Bot upgrades can be downloaded for free from https://shankydownload.com/hedownload.htm. Download and install the new version of the Holdem Bot to fix this error.

Error Code No 2: You must run the bot as administrator

This is a Vista specific error. If you see this, it means that you are not running the bot as administrator. To fix, close the bot and restart it by right-clicking on its icon and choosing “Run As Administrator.”

Error No 3: You must set style to Classic (Vista & Windows 7)

This error should occur on Vista and Windows 7 machines only. If you get this error code in conjunction with one of the other errors below, then fix the other error first and come back here only if you still get it after fixing the other errors.

To fix this error, set the Windows theme to Windows Classic. To do this, right click on an empty area on your desktop, select Personalize in the pop up menu, then click on Themes, then click on Modified Themes, and set the theme to Windows Classic. Restart the bot.

If the bot still gives this error after changing the Windows theme, then you will need to change the “Active Window Border” size. Right click on an empty area on
the desktop then choose Personalize in the pop up menu. In the dialog box that shows up, click on the Window Color link towards the bottom middle part of the dialog box. A dialog box titled “Window Color and Appearance” will pop up. The “Item” list in this dialog will show “Desktop”. Click on the arrow next to “Desktop” and choose “Active Window Border” in the drop down list. Set the size to 1. Again click on the arrow and choose “Border Padding” from the drop down list. Set the size to 0. Click on OK in the Window Color and Appearance dialog.

Error No 4: DPI Setting must be set to 96 dots per inch

**Windows XP:**
- Right-click on any blank part of the Windows desktop.
  - Select Settings.
  - Select Advanced.
  - Under the General tab, find the DPI setting. It can be changed by using the drop-down. Set to **96 dpi**.

**Vista:**
- Right-click on any blank part of the Windows desktop.
  - Select Personalize.
  - Select Adjust Font Size (DPI).
  - Set the default scale to **96 dpi**.

**Windows 7 & 8:**
- Right-click on blank area of Windows desktop.
  - Select Personalize.
  - Select Display (in lower left).
  - Set to: **Smaller - 100%**.

**Windows 10:**
- Right-click on blank area of Windows desktop.
  - Select Display Settings.
  - Under Change the size of text, apps, and other items
  - Select **100% (Recommended)**
Error No 5: Invalid caption height

Windows XP

On Windows XP this error could be due to an invalid DPI setting, invalid font size setting, or because you have messed with the “Active Title Bar” size setting.

If the error is due to an invalid DPI setting, then you will also get Error No 4. Fixing that error should fix this one as well. So fix that first.

If you still get this error, then the problem is likely caused by an invalid font size. To fix the font size issue, right click on an empty area on the desktop then choose Properties in the pop up menu. Click on the Appearance tab in the Properties dialog. Set Font Size to Normal and click on Ok. Restart the bot.

If you still get this error, then it is likely due to a non-default “Active Title Bar” setting. To fix that, right click on an empty area on the desktop then choose Properties in the pop up menu. Click on the Appearance tab in the Properties dialog and then on the Advanced button. The “Item:” list in the Advanced dialog will show “Desktop”. Click on the arrow next to “Desktop” and choose “Active Title Bar” in the drop down list. Set the size to 18 if you are using Windows Classic theme and to 25 if you are using Windows XP. Click on Ok in the Advanced dialog and then on Ok in the Display Properties dialog.

Vista, W7, W8, W10

This error could be due to Error No 3 (Style is not set to Classic) or because of Error No 4 (DPI is not set to 96 bits). If so, you will also get one of the above error messages. Fix those first according to the instructions for fixing those errors.

If on re-starting the bot after fixing the above errors, you still get this error message then you will need to change the “Active Title Bar” size setting. Right click on an empty area on the desktop then choose Personalize in the pop up menu. In the dialog box that shows up, click on the Window Color link towards the bottom middle part of the dialog box. A dialog box titled “Window Color and Appearance” will pop up. The “Item:” list in the Window Color and Appearance dialog will show “Desktop”. Click on the arrow next to “Desktop” and choose “Active Title Bar” in the drop down list. Set the size to 18. Click on Ok in the Window Color and Appearance dialog.
Error No 6: Invalid color quality

Color quality must be set to 32 bit color. The bot automatically sets this for you so you should never see this error. If for some reason the bot is unable to make the change for you, you will need to do it manually. On Windows XP this can be done as follows: Right click on an empty area on the desktop, then choose Properties in the pop up menu. Click on the Settings tab in the Properties dialog and set Color Quality to Highest (32 bits) and click on OK. (A similar path will exist on later Windows systems.)

Display Settings Trouble-shooting.

If you are certain that all your poker room settings are adjusted correctly as per the instructions above, and the bot is not giving you any error messages on startup, but you are still having trouble with the bot reading the buttons, or are getting invalid opponent count messages, or too many missed clicks reports, try the following:

From Control Panel find Performance Information and Tools.

Under Tasks, click Adjust Visual Effects.

Make sure Let Windows choose what's best for my computer is set. Do NOT set this to Adjust for best performance.

If all this fails, please Contact Us. We can solve most individual display settings issue by email.